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National Anthem
Jana-gana-mana adhinayaka, jaya he
Bharatha-bhagya-vidhatha.
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga.
Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharata-bhagya-vidhata.
Jaya he, jaya he, jaya he,
Jaya jaya jaya, jaya he!

Pledge
India is my country. All Indians are my brothers and
sisters.
I love my country, and I am proud of its rich and varied
heritage.
I shall always strive to be worthy of it.
I shall give respect to my parents, teachers and all
elders and treat everyone with courtesy.
I pledge my devotion to my country and my people.
In their well-being and prosperity alone lies my
happiness.



Dear Children,

Information and communication technologies (ICTs) have become so
pervasive that we cannot even imagine a world without them. The
growth of ICTs means that our grip on the world’s facts is increasingly
becoming stronger. It is necessary that we cope with this speed of
change. It is by keeping in mind this need that the ICT Text book for
Class X has been prepared.

In this book you will find the first lessons in graphic designing and
also how to animate your pictures as per your own script. You will
also get introduced to database management, which is in fact a
logical continuation of studying office tools.

We have been familiarising with the various aspects of Python
programming over the last couple of years. This text book has got
more exercises which will help you write more programmes
using the language. While you use various software applications and
do programming, you may seek to know more about the
machine that computer is and its operations. Therefore, we have
included sections on the hardware aspects and networking also.

We have understood about web pages and web sites. What about
preparing a web site for our school? The chapter ‘A Website for Us’
introduces certain software applications that help you handle the
content and design of web sites well.

You must have seen India’s and Kerala’s maps. But how many of you
would have seen your panchayat’s map? Scientifically
prepared maps are needed for local level development planning. We
have a chapter on ‘QGIS’ software that helps in preparing
comprehensive resource maps. Simulation software Stellennium and
mathematical software Geogebra are also included.

Practise the activities given in this text book and make your own
contributions to the ICT field.

Wishing you all success

Prof.  K.A.  Hashim
Director

SCERT
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CONSTITUTION OF INDIA
Part. IV A

FUNDAMENTAL DUTIES OF CITIZENS

       ARTICLE 51 A

       Fundamental Duties - It shall be the duty of every citizen of India :

(a) to abide by the Constitution and respect its ideals and institutions,
the National Flag and the National Anthem ;

(b) to cherish and follow the noble ideals which inspired our national
struggle for freedom ;

(c) to uphold and protect the sovereignty, unity and integrity of India ;

(d) to defend the country and render national service when called upon
to do so ;

(e) to promote harmony and the spirit of common brotherhood amongst
all the people of India transcending religious, linguistic and regional
or sectional diversities ; to renounce practice derogatory to the
dignity of women ;

(f) to value and preserve the rich heritage of our composite culture ;

(g) to protect and improve the natural environment including forests,
lakes, rivers and wild life and to have compassion for living
creatures ;

(h) to develop the scientific temper, humanism and the spirit of enquiry
and reform ;

(i) to safeguard public property and to abjure violence ;

(j) to strive towards excellence in all spheres of individual and
collective activity so that the nation constantly rises to higher levels
of endeavour and achievement.

(k) who is a parent or guardian to provide opportunities for education
to his child or, as the case may be,  ward between age of six and
fourteen years.
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1 The Beautiful World of Pictures

You know how to make a collage
using GIMP software. You also know
that GIMP is appropriate software for
making posters. Haven’t you seen daily
use products carrying the logo of the
company that makes them? Various in-
stitutions have their emblem or logo
displayed in their premises. Can you
download the logo of the IT@School
project under the department of educa-
tion, enlarge it and see? Does the logo

Raster and Vector
There are two ways of recording pictures in a computer – either as Raster files
or as Vector files. In Raster files, the colour of every point on the picture is
recorded. In these files, a picture is divided into numerous squares. For ex-
ample, consider a picture with 10 cm length and 8 cm breadth. This picture
could be divided into 1000 parts along length and 800 parts along breadth.
Then the area of each of the squares would be 0.1 square mm. There would be
100 parts in each centimetre. In other words, we could say that the picture has a
size of 100 dots per centimetre. However, traditionally the size is usually men-
tioned in dots per inch (dpi). We can decide the dots per inch that we require in
a picture that we handle. By increasing the dpi we can enhance the clarity and
beauty of the picture. For better print quality, we need pictures of higher dpi.

blur when you make it bigger? Can you
think of the reason for this? This is a
problem that we face when we engage
in such creative work. Increasing the
size of a picture blurs it. Have you
heard of mechanisms used for manipu-
lating pictures without losing their
clarity? Read the following note, discuss
among yourselves, and reach a
conclusion.
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Pic. 1.1

When we draw a line in a Raster file, what the computer does is colouring the
small boxes along that line. When we enlarge the picture, the boxes get
enlarged as well. You can view this while enlarging a picture in GIMP.

In a Vector file, it is only the colour of lines and the coordinates of the end
points that are recorded in the computer. When the picture appears, the com-
puter will interpret the coordinates of end points and interpolate to mark all
the points that fall between. When a picture stored as a Vector file is enlarged,
new points get marked in the enlarged surface. As more points are added along
with enlargement, the clarity of the picture remains.  Vector files store pictures
as geometric shapes such as lines, squares, circles, and arcs.

Pictures drawn using GIMP software are considered pixel groups. But Inkscape
software remembers the geometric shapes drawn in it in terms of mathematical
formulae. This is why Vector images are able to maintain clarity and beauty
when enlarged also.

Enlarge Pictures without
Losing Clarity

Now we know the properties of
Raster and Vector images. We need spe-
cial purpose software to construct and
edit pictures without losing out on clar-
ity. Open Office Draw, Coral Draw,
Inkscape, Adobe Illustrator, Dia etc., are
software applications used for making
Vector images. Among these, Open

 Office Draw, Inkscape, and Dia are
open source software.

Let us now see how to make pic-
tures in Inkscape software. Select
Inkscape Vector Graphic Editor from
Graphics menu.

Observe the Inkscape window
(Picture 1.1). Find out the similarities
and differences between Inkscape and
GIMP and fill up Table 1.1.
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Similarities  Differences

• Various tools
and canvases
are available

• Tools and can-
vases are in the
same window in
Inkscape. They are
in different win-
dows in GIMP.

• .................................

• .................................

• .................................

• ............................................

• ............................................

• ............................................

Table 1.1

Pic. 1.2

Pic. 1.3

Remember the tools that you have
become familiar in GIMP. Are all of
them available in Inkscape? Do you see
in Inkscape any tool which was not
available in GIMP? You know about
GIMP tools from your previous class.
Now let us take a look at Inkscape tools.
Bring mouse pointer above the tools
that are numbered and identify their
names. Try using each tool and tabu-
late their uses. (Table 1.2).

Tool  Name Use

  1. Selection Tool For selecting an Object

  2. ............................ ............................................

  3. ............................ ............................................

  4. ............................ ............................................

  5. ............................ ............................................

  6. ............................ ............................................

  7. ............................ ............................................

  8. ............................ ............................................

  9. ........................... ............................................

Table 1.2

Activity 1

Constructing a Logo
What is shown in Picture 1.3 is a

logo constructed in 600X150 pixel size.
Let us construct the same logo using
Inkscape software. Think about the vari-
ous tools that could have been used in
constructing this logo? Observe and
note down your inferences below.

♦ ..............................................................

♦ ..............................................................

Steps

♦ Open Inkscape software and con-
struct a canvas. For this, click Docu-
ment Properties in File menu. In the
window that opens, use Custom Size
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option to make adequate changes.
Close the window (You can select
canvas of different sizes from Tem-
plates in the window).

♦ Use Create Rectangle Tool  to
construct three squares as shown in
Picture 1.3.

♦ Select the squares and adjust the size
by changing Object Size. This could
be done by altering the Height and
Width in the Tools Control Bar.

♦ Colour the squares by selecting them
and clicking appropriate colours in
the colour palette.

♦ Type IT@School inside the square

using Text Tool .

♦ Adjust the text size to suit the
squares using Select and Transform

Object Tool .

♦ Render appropriate colour to the
text by selecting colours from the
palette.

♦ Save the file in your folder.

♦ Magnify the logo using Zoom in or

out tool .

Compare the following.

♦ The logo magnified using Zoom In
tool after opening it through GIMP
software

♦ The logo prepared using Inkscape
and magnified using Zoom In tool

Can you note down the differ-
ences?

♦ ............................................................

♦ ............................................................

♦ ............................................................

Try moving around the logo that
you have made in Inkscape. Do you
experience any problem? It is not pos-
sible to move the objects together; isn’t
it? Analyse the note below and exam-
ine.

Each shape (line, circles, square etc.)
drawn using Inkscape is an object. We
can select all the objects in a
workspace using Select All (Ctrl+A)
in the Edit menu. We can also select
the objects in a portion of the
workspace. When you click on the
Select tool and drag, all the objects
within the rectangle that forms get
selected. In order to select more than
one object, click on each while
keeping the Shift key pressed. The
part thus selected can be dragged to
any slot within the workspace. We can
also convert the selected objects into
a single unit using Group function in
the object menu (ctrl+G). The objects
that are ‘grouped’ can be moved
around as a single unit.

In order to prepare good pictures
in Inkscape, creativity should be sup-
ported by sound understanding of vari-
ous tools and menu options, and their
uses. You should be able to use these
tools and options effectively. This re-
quires regular practice with a lot of pa-
tience. You can develop these skills by
practising the activities provided in the
subsequent section.
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Pic. 1.4

Pic. 1.5

Activity 2

You must be familiar with spheres,
cylinders, pyramids etc., from your
mathematics lessons. You might have
also drawn these objects on paper.
While drawing on paper, these objects
can be represented only in two dimen-
sions. How do we make these objects
look three dimensional? It is through
appropriate use of light and shade that
we render these pictures a three dimen-
sional effect. Let us see how we can
make a sphere using Inkscape.

♦ Draw a circle using Create Circle

Tool  and colour it

♦ Select Gradient Tool and click on
Create Radial Gradient on tools con-
trols bar (Picture 1.5)

♦ Double click within the circle. You
will get a gradient corresponding to
the selected colour

Did you notice the three nodes re-
lated to gradient? Try moving the nodes
using Edit Path by Node Tool .

What difference do you notice?

Select the square node at the inter-
section of the two lines and click on the
colour palette. Select one of the other
nodes and take another colour. Repeat
these using different colours. It is a com-
bination of the selected colour and the
nodes at which they have been selected
that make the circle look like a sphere.
Observe the colours and the nodes at
which they have been selected that
made the circle appear spherical.
Change the positions of light and shade
by moving the nodes. Now you can also
try constructing other objects in the
same method. While constructing a
cylinder, try to understand the use of
Union in Path menu with the help of
your teacher.

Activity 3

You must have studied about
amoeba in your biology class. Do you
recollect the properties of amoeba?
They are single cell organisms without
any specific shape. Now let us try
drawing an amoeba using Inkscape
(Picture 1.6).

Steps

♦ Draw a polygon using Draw Bezier

Line Tool .

♦ Manipulate the sides of the polygon
appropriately using Edit Path by
Node Tool

♦ Click on the Gradient tool to select
radial gradient and colour it

♦ Use circle tool to draw the parts of
the cell such as nucleus and
pseudopodia, and colour them us-
ing gradient tool
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Fill and Stroke

See Picture 1.7. The stroke of this object is the back circle. The blue portion is
called Fill. In order to see the various options relating to these, open the dia-
logue box shown in Picture 1.8 by clicking Object →→→→→ Fill and Stroke. Select the
object and try out the tabs and options for understanding their uses.

Pic. 1.7 Pic. 1.8

Pic. 1.6

♦ Use Object →→→→→ Fill and Stroke
method to give appropriate colour
to the cell mass fluid (Pictures 1.7
and 1.8)

♦ How will you mark the parts of a
cell? Find out the method and mark
the parts

Try drawing an amoeba by
manipulating a circle. Can you figure

out a way to make copies of the amoeba
that you have drawn? By understand-
ing a few more techniques, you will be
able to easily make copies. Use Edit →→→→→
Duplicate to make a copy. Now use
selection tool to move that object from
the original slot. This was you can copy
any number of amoeba by grouping and
duplicating objects drawn in Inkscape.
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Pic. 1.9

Pic. 1.10

 Key          Changes Observed

Page Down The selected object moves
behind the other object.

.

Table 1.3

Page Up        .................................................

End        .................................................

Home        .................................................

Stack two or more objects one
above the other, select anyone of them,
and press the following keys – Page
Down, Page Up, End, Home. Note
down your observations in Table 1.3.

Usually it is object that has been made
the last which appears at the top
(Picture 1.9). Sometimes you may
have to bring them below other
objects. In order to do this, select that
particular object and use the option:
Object →→→→→ Lower. Instead of this, you
can also use Page Down key.

Activity 4

Most schools have the gate in the
form of an arch, with a banner bearing
the school name. See such an arch shown
in Picture 1.10. Discuss the tools needed
to draw this and note them down.

Required Tools:

♦ The tool to draw circles

♦ .............................................................

♦ .............................................................

♦ .............................................................

♦ ............................................................

Use Picture 1.10 and the steps listed
below to construct a banner for your
school in Inkscape.

Steps

♦ Draw a circle

♦ Convert it into a semi circle using
Edit Path Node

♦ Make two duplicates using Edit →→→→→
Duplicate. Reduce the size of the du-
plicates and arrange them as shown
in Stage 3 of Picture 1.11

♦ Type in your school’s name using
text tool

♦ Select the semicircle in the middle
and the text together. Select Text →→→→→
Put on Path option. Your school’s
name gets arranged along the cen-
tral semicircle. Provide adequate
space before the text and do proper
spacing.

♦ Select the central semicircle and re-
move its stroke colour and fill colour
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Pic. 1.13

Pic. 1.14

Pic. 1.12

Let us now see how to save selected
objects in a picture as raster files. First
select the required portion of the
picture. Take File →→→→→ Export Bitmap
option. Click on Selection tab, assign
a file name and Export. The selected
portion alone gets saved as raster file
in .png format (Picture 1.11). Observe
the other options in Export Bitmap
dialogue box. Try out and understand
their uses.

Pic. 1.11

♦ Select the other two semicircles
together and click on Path →→→→→ Differ-
ence option

♦ Use the following note to save
Picture 1.11 in .png format.

Activity 5

What is shown in Picture 1.13 is a
flower drawn in Inkscape. In addition
to the tools that you have already used,
a few additional ones have also been
used here. Draw a flower using the
steps given in Picture 1.14 and save it
in your folder.

♦ Draw a line by clicking Pencil tool

 at the top and bottom

♦ Select the line, use Edit →→→→→ Clone →→→→→
Create Tiled Clones. In the dialogue
box that opens, select PM:Reflection
from Symmetry tab. Provide 1X2 for
Row and Column, click Create and
close the dialogue box.
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♦ Select the line, use Edit →→→→→ Clone →→→→→
select original option. Click on the
line using Edit Path by Node tool
and drag the line to one side. The
line bends symmetrically to both
sides. Make it into the shape of a
petal. Select it fully and use Fill
option to colour it.

♦ Now select the petal in full and use
Edit →→→→→ Clone →→→→→ Unlink Clone
option. Select Path →→→→→ Union. This
makes the petal an independent
object.

♦ Make duplicates of the petal and
arrange them in the shape of a flower
using tools such as Rotate and Flip

in the Object menu.

♦ Select all the petals together and use
Path →→→→→ Union.

In order to rotate an object in a given
angle, open the dialogue box using
the option Object →→→→→ Transform. Use
the tools in Rotate tab in the dialogue
box. It is possible to arrange the
petals by double-clicking on the
petals also.

What all need to be done now to
develop this into the flower shown in
the picture. Use the other techniques
that you have learned to complete the
picture.

Additional Activity

Inkscape is a software application used
in drawing pictures to produce animation.
Try making such a picture using this soft-
ware. In order to animate a picture, we have
to drawn each of the moving parts separately.
You know that the pictures drawn in Inkscape
are combinations of objects. You also know
how to do grouping of objects. In addition,
you know how to select parts of a picture and
save them as raster files. Now try drawing
the picture of a bird for animation. Save its
body, wings, beak, and eyes as separate files.
The files thus saved can be used when you
learn animation.

Pic. 1.15

Follow up Activities

♦ Construct your school’s logo using
Inkscape and save it as a raster file
in your folder. Include this logo in
the home page of your school’s web
site.

♦ Draw the different stages of phago-
cytosis in the safety and health care
chapter of your biology text book
and save it in your folder.

♦ Refer to the dialogue between
Damayanti and the swan in
Nalacharitam Attakkatha given in
your Malayalam textbook. Prepare
the drawings of different body parts
of a flying swan and save them as
individual files in your folder for
later use in animation.
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We know the importance of data
collection for academic activities. There
are various methods for data collection
and analysis. You have done data col-
lection and analysis on the health as-
pects of children in Class IX. In order to
draw out reliable inferences through
appropriate analyses, it is necessary to
first tabulate the data systematically.

What were the problems that you
faced while tabulating the data on the
health habits of children in Class IX?

♦ Size of the table

♦ ............................................................

♦ ............................................................

♦ ............................................................

How did you address these prob-
lems? What where that techniques that
you used?

♦ Cell freezing

♦ ............................................................

♦ ............................................................

♦ ............................................................

♦ ............................................................

Now let us understand some new
ways of addressing the problems faced
in tabulating data

Data Form for Tabulating data

Let us see how to use Data Form to
tabulate data. Let us do this by prepar-
ing a table comprising the names of the
children in your class, their house
names, age, addresses, and parents’
names. In order to do this, type in the
required titles in Open Office Spread-
sheet and select (Picture 2.1).

2 New Methods in Data Analysis
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Now open the Data Form window
by selecting Data → Data Form  (Pic. 2.2).

See the boxes that appear in Data
Form. Each box corresponds to a title
given in the spreadsheet. Type data in
all the boxes and click New button. See
the changes that occured in the table.
Practise entering data in other tables too
using Data Form.

Let us prepare Health Card

It has been decided to collect infor-
mation on height and weight of children
as part of total physical efficiency
programme. Can we tabulate the data
collected and prepare health cards for
the children in your class? We can use
Data Form for tabulating the data re-
quired for health card.

What are the types of information

to be included in health card?

See the model questionnaire for
data collection.

Prepare a similar questionnaire in
Open Office Writer and collect informa-
tion on all the children in your class.

We can include body mass index
(BMI) and some analysis based on
B004DI to improve the health card. For
this, we have to tabulate the available
data and analyse it. As a first step, tabu-
late the data collected using Data Form
tool in spreadsheet.

Look Up Function for
Classification

From the table that you have pre-
pared, children can be classified based
on BMI. Let us have four categories –
Those who are underweight, children
of normal weight, those who are over-
weight, and those who are obese. Let
us label these categories as ‘Under-
weight’, ‘Normal weight’, ‘Overweight’,
and ‘Obese’. In order to do this classifi-
cation, calculate BMI for all in the table.
BMI is calculated by dividing the
weight in kilograms by the square of the
height in metres. Children can be clas-
sified based on BMI as mentioned
above using Lookup function in

Pic. 2.1

Pic.  2.2

 Health Card - Questionnaire for Data Collection

Admission No. ......................................................

Name ......................................................

Class and Division ...............................................

Height ......................................................

Weight ......................................................

Age ......................................................
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spreadsheet. For this, you have to prepare a Lookup chart in the table that you
have made. See the model given below (Picture 2.3).

For classifying children using Lookup chart, select the Lookup chart, and
use define Range from Data menu. Assign a name and save it.

Pic.  2.3

Pic.  2.4
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this database? Copying the individual
data for each student and preparing re-
ports is laborious. We can make this
easier by arranging the data relating to
each student in an appropriate manner.
Mail Merge is a technique that helps us
do this.

Once the database for preparing
health card has been completed, make
a template for health card using Open
Office Writer. A model is given on
Page 21.

Now we have to include relevant
information from the database that you
have prepared into the template file. For
this, select Mail Merge Wizard from
Tools menu. In the window that opens,
click on Insert Address Block. Select
Address and click on Add button. This
inserts the table into the document. If
tick marks are seen in the window, de-
select them, and click Create Salutation.
In the window that opens, de-select tick
marks and select Edit Document option.
Then you can press Edit Document but-
ton and return to the main document.
Now click Data Source in Edit menu

Select the cell containing data on
the first student (the shaded cell) and
click on Function from Insert menu.
From the list that appears, select
Lookup. The subsequent windows
(Picture 2.4) will ask for three param-
eters – Search Criterion, Search Vector,
Result Vector. What do these indicate?

Search Criterion: What is the data
based on which the student has to be
categorised?

Search Vector: The name assigned
while defining Data Range.

Add the relevant information and
click OK to get information on the first
student in the corresponding cell. What
needs to be done to make information
available in the cells below? Find out
and complete the table.

Individual Data from Table

We can consider that table that you
have just made as a database. How can
we prepare individual report of each
student (Health card for example) from

Database

Collection of various information on a subject is called a database. Once a large
database is prepared, finding specific information from it is difficult. How-
ever, information in a computer database can be easily found using software.
This is a technique to use data in digital form. It can be considered a collection
of files containing different types of information. Files in a database are usu-
ally called tables. A database may have single or multiple tables. While a data-
base is the collection of various files, different types of information is stored in
different tables. For example, if the information on the students and teachers in
a school are part of a database, information on students and teachers would be
typically stored in different tables.

Unlike other file types, database files do not allow direct access for communi-
cation. We communicate with them through database management systems or
application programmes. And for the same reason, files in databases are more
secured.
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(Picture 2.5); the inserted table appears
at the top of the document (Picture 2.6).

You can click and drag the titles in
the table to place them appropriately
in the document. Click on the window
to return to Mail Merge Wizard; select
Save Merge Document in the new win-
dow and save. Examine the pages in the
new file. Now you can print the health
card.

What are the other reports that
could be prepared from this database?

♦ Identity Card

♦ Conduct Certificate

♦ ............................................................

♦ ............................................................

GHSS AVITANALLUR
Health Card

Name .............................................................

Address .............................................................

Class .............................................................

Age .............................................................

Height .............................................................

Weight .............................................................

BMI .............................................................

Comment .............................................................

              Signature of the Class Teacher

Model of Health Card

Pic.  2.5

Pic.  2.6
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purposes. You have now familiarised
some preliminary forms of databases.
You have also understood the way the
information from a database is used for
different purposes. Spreadsheets have
several limitations in database prepa-
ration. Suppose the same admission
number was given wrongly to two stu-
dents in the earlier database. Spread-
sheet saves both the entries as there is
no inherent mechanism to check such
errors. When we handle large databases
in a secured way, we have to consider
several aspects like this. We need cross
checking mechanisms for that. Avoid-
ing duplicate entries, eliminating the
possibility of letters getting typed into
cells meant exclusively for numbers etc
are examples.

Software applications that allow
secured handling of databases with
mechanisms to pre-empt common er-
rors are called database management
systems (DBMS). Open Office Database
is such a database management system.
Open and see the Open Office Database
from the Office menu. What all does the
software ask for? Examine each win-
dow, provide the required information
and construct a new database. Before
opening your new database, the soft-
ware asks you to save it. Why does it
do so? Discuss.

Observe the Open Office Database
window (Picture 2.7). Find out and

CERTIFICATE

     Certified that Master/Kumari. Rajeev. K,
Standard 10 A is Selected to participate in
the  Volly Ball Team Selection Camp 2012.
His/Her height is 162 cm.

Place Signature of Class Teacher
Date

Practice by making similar reports.

A new Method for
Classification

The training camp for selection to
the school volley ball team is about to
begin. It is those with more than 160 cm
height who will be included in the
camp. Class teachers have to issue
certificates to the children shortlisted for
admission into the camp.

How can you prepare a list of
eligible students using the database that
you already have? You can do that by
categorising students who have more
than 160cm height and those who do
not. An easy way is to mark ‘Selected’
in the column next to the one with the
data on height for children with more
than 160 cm height. Others can be
marked ‘Not Selected’. Once this is
done, Mail Merge tool can be used to
generate the certificate. But how do we
mark these? Conditional Statement is a
method for doing this. We can use ‘If’
function for this. Click on the cell in
which we have to mark the status of
selection and select ‘If’ function. In the
window that opens, mark the condition
for height (H>=160) in the Test field and
the corresponding result (Selected) in
Then_value field. Type ‘Not Selected’
in the Otherwise_value field and click
OK. What do you see in the cell? How
can you include the details of other
children in the rows below? Now
prepare certificates for all students
using Mail Merge tool in the model
given below.

Let us prepare a Database

Databases are pools of information
collected and consolidated for specific
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distinguish across data sets, we have to
define a primary key. Data defined as
Primary key has to be unique as well as
mandatory (In other words, data which
is not further repeated in the database,
and the fields of which cannot be left
empty/null). Decide on the data that
you would like to define as primary
key, and right-click on its left side.
Select the option ‘Primary Key’ (Picture
2.8). Please do not forget to assign a
name and save the table.

Form for adding information
into the Table

A technique called ‘Form’ can be
used for adding information into the
table. Click ‘Form’ button in the Open
Office Database window and select the
second option (Use Wizard to Create
Form). Proceed further and you will be
able to select the table that you have
prepared and the specific pieces of data
/ information that you want to include
in ‘Form’. Proceed after selecting a

Pic. 2.7

tabulate the various functions for which
you can use this database application.

Tables : For tabulating data
Quaries: For finding out specific infor-

mation
Forms : ..................................................
Reports: ..................................................

Tabulation

There are three ways for tabulating
data using Open Office Database. Se-
lect the first method (Create Table in
Design View). We can decide on the
titles and the data type to be included
under each. For example, admission
number is a ‘Numeric’ data while name
is ‘Text’.

Let us prepare a database which
contains the admission numbers of
students, name, class, date of admis-
sion, and parents’ names. As a first step,
we have to specify the titles needed and
define their data types. In order to
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Pic. 2.8

Pic. 2.9

layout from ‘Arrangement of the main form’. Save the form after selecting a suit-
able layout and colour for the Form (Picture 2.9).
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Now try using this ‘Form’ to tabu-
late data. After adding data in each of
the fields that you have created, you can
use ‘Tab’ key to go to the next field. Once
you press ‘Tab’ or ‘Enter’ key after add-
ing the data on a student, the informa-
tion get stored in the table that you have
made. Enter data this way and open the
table and see. This table can be used for
other purposes too using techniques
such as Mail Merge. Practise more by
creating new databases using Open Of-
fice Database.

Follow up Activities

♦ Collect the required data for mak-
ing identity cards of all your class-
mates and use Open Office Data-
base to prepare the database. Pre-
pare identity cards using Mail
Merge technique and print them.

♦ Collect data on household water
sources in a ward. Tabulate the data
using Open Office Database and
prepare a Form for data input.
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How beautifully S.K. Pottakkad
depicts the changes in the natural
surroundings even as Athiranippadam
developed into a habituated area! Don’t
you see similar changes in and around
your place as well? Is it possible to
mark the geographic and manmade
changes in your area in a map? What
kind of a map can we use for it? In
order to decide on this, let us take a
look at different types of maps.

Wall Maps
Observe any wall map that you are

familiar with and find out the details
available in it (Picture 3.1).

♦ Roads
♦ Railway
♦ ............................................................
♦ ............................................................

‘It was through the slow drying up of a large swamp that Athiranippadam
evolved into a habituated area. In ancient time, a small river used to flow through
it and drain out into the sea a mile towards the western end. As centuries passed
by the river dried up, silted, and transformed into a large canal. Even now that
area is called Riverside. Slowly the canal too dried up and changed into a swamp.
When eventually the swamp started drying up, people entered the fields. Signs
of hard work became apparent on the fields. Sugarcane farms, fields where pulses
grew, and marked out habitats came up there...’

’Oru Desathinte Kadha
S.K. Pottakkad

3 My Resource Map
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Satellite Maps
Visit the website www.wiki

mapia.org and identify your locality.
What additional information is avail-
able in these maps in comparison with
a wall map?

♦ Houses

♦ Panchayat Roads

♦ Pond

♦ ............................................................

♦ ............................................................

We can mark the names of places,
roads, institutions, places of worship
etc., in wikimapia. Locate your school
in the map.

Pic.  3.1

Pic.  3.2  Satellite View
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How do we mark the name of our
school in wikimapia?

My School Too in Wikimapia
After opening wikimapia you can

locate your school either through search
or mouse scroll. We can see the map in
two views – Satellite view and Map
view. Once you have located the school,
select ‘Add Place’ from ‘Edit Map’ menu
from the tools available atop within the
map window.

Pic. 3.3  Map View

Pic. 3.4

Pic.  3.5
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You can mark your school by
creating nodes by mouse clicks on the
map. Similarly mark your own house
also in the map.

Click ‘Save’ button. Provide the in-
formation asked for in the window
which opens and save the changes.

QGIS Map
Now visit the web site

keralaresourcemaps.in and see the
webQGIS map of Akathethara Grama
Panchayat in Malamuzha Block of
Palakkad District. See the legends pro-
vided on the left side of the map on the
geographic information of the Grama
Panchayat available in the map. What
are the themes that are available in the
map? We can see any of the available
themes in the map by clicking the
mouse on the check box given on the
left side of the corresponding legend.
Find out the attributes available in dif-
ferent categories by activating the

Pic.  3.6

GIS se hnhn[ hnhc ]mfn-IÄ
♦ AXnÀ¯n ]©m-b-¯p-IÄ
♦ ]©m-b-¯nse BkvXn-IÄ
♦ t»m¡nsâ AXnÀ¯n
♦ I\m-ep-IÄ
♦ ISÂ AXnÀ¯n
♦ sN¡v Umw sIt«- Øe-§Ä
♦ ag-¡p-gn-IÄ Ipgn-t¡- Øe-§Ä
♦ ......................................................
♦ ......................................................
♦ ......................................................
XpS§n [mcmfw ]mfnIÄ QGIS am¸nÂ
ImWmw.

corresponding legends and clicking on
the map.

We have examined three types of
maps already. Among these, QGIS
maps have the most information avail-
able on natural and manmade features.
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Information provided in QGIS maps can
be used for local level planning and
analyses.

Please take note of the description
of the uses of such maps in the second
chapter of the Social Science II text book
of Class X. Now let us understand about

QGIS maps and their uses.

See the ward map given in Picture
3.7. See the main road shown in it.
Suppose it has been decided to increase
the road’s width by 10 m. Can we find
out which all buildings will be affected
by such a development? This is pos-
sible in a QGIS map as the software has

Pic. 3.7

QGIS
Suppose you have prepared an ordinary wall map which captures most of

the important features of your place. It would take a lot of effort to analyse the
information in the map and use it for any purpose.

On the other hand, suppose we construct a map by preparing individual
layers of spatial themes. And suppose we have the facility to analyse the
information by overlaying these layers as well as separating them as per our
requirement. Then extracting information and analysing them using such maps
would be easy. It would also add to the precision of our analysis. QuantumGIS
or QGIS is an important software application that helps us construct maps by
arranging spatial themes in different layers.



Information and Communicatio Technology

30

a feature that facilitates this. The
technique used for this is called
‘Buffering’. Let us see how buffering is
done.

Buffering
In order to do this, we need the

digital form of the QGIS map shown in
Picture 3.7 (QGIS Project). We can open
the map in the geographic information
system software Quantum GIS. After
opening QGIS, use ‘Open Project’ com-
mand in ‘File’ menu to open QGIS
Project in your software. Observe the
legend box on the left side and note the
layers visible in the map. Activate the
layers shown in legend box by clicking
in the check boxes.

We can find out the buildings that
will be affected by a ten metre widen-
ing of the main road in the following

way.
♦ First select the layer ‘Road’.

♦ Use ‘select single feature button’ 
to select the main road button in
the map.

♦ Click in the following order:
Vector → Geo processing Tool →
Buffer(s).

♦ Select ‘Roads’ as ‘Input Vector
Layer’

♦ Provide 10m as ‘Buffer Distance’
for Main Road

♦ Click the ‘Browse’ button in ‘Out-
put Shapefile’, assign an appropri-
ate file name for the layer, and save
it. Also allow for adding new lay-
ers.

♦ In the layer box, drag  ‘Road Layer’
to place it above ‘buffer_roads’

Pic. 3.8
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layer. Similarly, drag and place
‘House Layer’ above ‘Road Layer’.

Now can you observe the map and
identify  the buildings that are likely to
be affected by the proposed road wid-
ening?

We can ‘Zoom in’ to see more
details. For finding the buildings that
would be affected, click on the Houses
layer.  Click on the ‘Identify Features’

tool  and click on the points
indicating each of the houses. See what
all information have been included on

the houses while constructing the map.

Adding a New Layer
Did you notice that all the houses

are marked on the same layer of the
map? There are usually open wells near
the houses. However, wells have not
been marked here. How can we mark
them?

♦ Click in the following order from
Qgis menu  Layer → New → New
Shapefile Layer.

♦ In the dialogue box that appears,

Pic. 3.9

Geo-referencing

Geo-referencing is the process establishing the relationship between the pla-
nar coordinates of a map and real world coordinates (latitudes and longi-
tudes).  Once we scan a map and bring in the image into QGIS, we need to
geo-reference it. The first step in doing this is to identify major landmarks in
the area shown in the map. We can find out the latitudes and longitudes of
these landmarks by means of Global Positioning System (GPS). The map is
then scaled up based on these. Once geo-referenced, we can identify every
point in a map with respect to the actual locations.
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Pic. 3.10

Table  3.1

Layer (Layer Type) Attributes

Boundaries Polygon Name of Grama Panchayat/Ward/
Population, Number of houses etc.

Ponds Polygon etc. Ownership, Water availability, Use

Household Land Polygon Survey Number, Land Use, Soil
Type, Ownership

Rivers Lines Name, Width, Water availability etc.

Streams Lines Name, Width, Water availability etc.

Paths Lines Name, Type (Main Road or
Panchayat Road), Width,
Surface type etc.

House Point House Number, House Name,
Number of inhabitants, roof (RCC
or tiled or thatched)

Well Point Ownership, Water availability, use,
state, depth, water quality etc.

Public Building Point Name, type, building number etc.
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mark the Layer Type (From the
given table).

♦ In the Name box below New
attribute, provide appropriate
Attributes.

What are the Attributes that can be
used? Find out from the table. In the
type box below Attributes, you may add
additional attributes as well. While us-
ing alphabets (letters), you may specify
‘text data’. Similarly for numbers, you
may specify ‘Whole Number’ or ‘Deci-
mal Number’. After giving every At-
tribute, do not forget to click on the tab
‘Add to attributes list’. After entering all
the required information, do not forget
to assign the file name ‘well’ and save
using ‘OK’ button. See the new layer
titled ‘well’ appearing on the left hand
side. Right-click on the layer, open
‘properties’ and see. Find out the extent
to which you can modify this layer (Pic-
ture 3.11).

We have to now mark wells on this
layer. Use the following steps to mark

Pic. 3.11

wells one by one.

♦ Select ‘Well’ layer from the layer
box.

♦ Click on the ‘Toggle Editing’  
button in the tool bar.

♦ Press the nearby ‘Capture Point’
button   which gets activated
with the above step.

♦ Click on the spot where you need
to mark the well adjacent to the
house.

♦ In the Attributes window that
opens (Picture 3.12), provide re-
quired information and click ‘OK’.

You may now use the same
method to create adequate layers to in-
clude household land, ponds, rivers
etc., in the map.

Let us make our Maps
attractive

In the maps that we prepare, let us
see how to mark title, scale, direction
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(North Line), and legend?

  In order to do this, click ‘add new
map’ tool in the composer window that
appears when you select ‘New Print
Composer’ tool in the ‘File’ menu. Now

Pic.  3.12

click and drag in a slanting direction in
the canvas below. The map appears. Use
appropriate tools to adjust the map size
the way you want it to be (Picture 3.13).
Find out what other changes can be
made on the map using ‘general’ and

Attributes

Options are available to enrich the
basic information provided in maps
through provision of additional at-
tributes. For example, additional at-
tributes such as survey number, area,
soil type, water availability, land use
etc., can be added to the attributes of
farmland. It is also possible to select
these attributes using ‘Identify fea-
tures’ option in the ‘View’ menu. All
the information  that we have input
would also be available in tabulated
form from ‘Open Attribute Table’ in
the ‘File’ menu.

Using GIS geographic information
system

Suppose we want to consider using
fallow land to promote paddy culti-
vation. We can analyse the situation
by overlaying soil type, contours, and
water sources on the layer showing
cultivable fallow land.

Similarly by laying paddy layer over
roads layer, we can estimate the area
of paddy fields that would be af-
fected by the construction of new
roads. Thus, use of GIS maps has be-
come essential in local level planning
today.
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‘item’ in the ‘properties box’ on the right
hand side.

For assigning title, click on the can-
vas after selecting the ‘add new label’
tool in the composer window. A text box
with the label Quantum GIS appears. By
making changes in the label box on the
right hand side and providing appro-
priate name, the title can be displayed
in the text box.

For adding legend, click on the can-
vas after selecting ‘Add new vect leg-
end’.

Now click on the canvas after se-
lecting ‘add image’ in the tool bar. Mark
‘North Line’ symbol from the ‘Picture
Option’ that appears on the right hand
side. Familiarise with other similar
tools in the compose window.

Open ‘File’ → ‘Export as Image’ and
save the map in the appropriate format.

Follow up Activities

♦ Prepare a QGIS map showing your
house and adjacent areas in the map
of the Grama Panchayat.

♦ In the map of the school ward pre-
pared in QGIS, find out the number
of wells within 50m radius of the
school using frequency analysis.

♦ Construct India’s different agro-cli-
matic zones in different colours.

♦ Use GIS software to construct the
areas cultivating wheat in the chap-
ter ‘India – Economic Geography’
(Page 87).

Pic.  3.13
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We have already learned how to
construct geometrical shapes using the
computer language called Python. We

have also used Python to build ‘count-
down clock’ and solve simple algebraic
operations.

Table 4.1 : Some of the Python commands we have familiarised so far

4 Computer Language

Command Example Use

import   from turtle import*

raw_input   a=raw_input(“Enter your Name:”)

if    if(n>10)
     print “Greater than TEN”
   else
 print ”Less than TEN”

range    i=range(5)

for    for i in range(11):
        print i

For including time module in
the programme

import    import time

For printing the value as-
signed to the variable ‘s’ in
turtle graphics window

write()     write(s)

For including all the turtle
graphics in the programme

For assigning a name for the
variable ‘a’ through keyboard
For printing the value of vari-
able ‘n’ as ‘Greater than TEN’
or ‘Less than TEN’ as the case
may be

In order to assign integers
0,1,2,3,4 for the variable ‘i’

For printing the numbers
assigned to the variable ‘i’
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Some of the Python commands and their uses that we have picked up in
classes VIII and IX are shown in Tables below.

Now let us understand more about
Python language

‘While’ in Place of ‘For’
We know ‘For’ is the command for

executing iterative operations. In com-
puter languages such as Python, ‘while’
command is also used for the same pur-
pose as ‘for’ command. An example of

the same programme written using ‘for’
and ‘while’ commands is given below.
Run both the programmes and see. You
can open ‘IDLE’ from Programming
menu and run it by typing in the
programme.

Once you have run the programme,
find out the following.

Table. 4.2

Table 4.3

Python Command Application

a=range(1,10) In order to assign numbers 1 to 10 in variable ‘a’

i=i+1 For adding 1 to the number already assigned to
the variable ‘i’

a=range(2,21,2)

The Python command to repeat the operation of
certain commands a specific number of times

for

a=range(3,31,3)

for i in ranges(5,51,5)
             print i

clear()

circle(100)

a=range(10,1,-2)

write(s, font=(“Arial”,30)) For printing the value of the variable ‘s’ in the
turtle graphics window in different styles

Program 1 Program  2

from turtle import*
clear()
for i in range(8):
   rt(45)
   circle(50)

from turtle import*
clear()
i=0
while(i<8):
    rt(45)
    circle(50)
    i=i+1
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♦ Name the iterative command along
which we use ‘range’ function?

♦ What would have been the result if
we had not used the command
‘i=i+1’ in the second programme?

♦ What was the purpose of the com-
mand ‘i=0’ in the second
programme?

Functions in Python
You are familiar with the functions

such as SUM, AVERAGE, and COUNT
used in software such as Calc and
Writer. Similarly, it is possible to for-
mulate functions in Python language
too which can be used for simplifying
mathematical operations and executing
iterative steps. Functions thus formu-

The ‘for’ command within a ‘for’ command

We have learned in previous classes to arrange the commands for a
specific number of iterations within a ‘for’ command. Similarly, we can use a
new ‘for’ command within the span of another ‘for’ command. In other words,
we can use ‘for’ commands within a ‘for’ command.

The activity that you did in the section ‘Computer Kalamezhuthu’ (Com-
puter Floor Art) is given below in two different ways. Comparing the high-
lighted lines in the programmes, you can appreciate the method in which ‘for’
command is used within another ‘for’ command. Observe Method 2. In this, the
command for j in range (30,91,10): is used within the command for i in range(8):

The following table shows the iterations that each command undergoes in
Method 2

Commands Number of Iterations

from turtle import*

clear()

for i in range(8):

  rt(45)

  for j in range(30,91,10):

     circle(j)

1

1

8

56

Method 1    Method 2

from turtle import*
clear()
for i in range(8):
   rt(45)

circle(30)
circle(40)
circle(50)
circle(60)
circle(70)
circle(80)
circle(90)

from turtle import*
clear()
for i in range(8):
   rt(45)
   for j in range(30,91,10):
        circle(j)

Table  4.4

Table 4.5
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lated can be used in other programmes
as well.

The following is a programme to
find the sum of two numbers
(Programme 3).

The function of each of the lines in
the above programme is provided
below

Program 3

def sum(a,b):

  c=a+b

  return c

Method to include Python
functions in new Programs

Type down the function in
Programme 3 and save it in your folder
assigning the file name myfunction.py.
Then prepare the programme given
below (Programme 4) in the same folder
and run it. Alternatively you may run
the commands in this programme in
Python shell.

Activity

Observe the output of Programme
4 and complete Table 4.4. Then add a
function to find the product of two num-
bers to the programme myfucntion.py.

Strings
Strings are data expressed in alpha-

bets. Numbers given within quotes are
also considered strings. In Programme
4, if you type in a command ‘print
myfunction.sum(“Good”,”Morning”)’,
and run it, the computer will print
‘Good Morning’ also as output. This
happens because Python did not

Program 4

import myfunction

print myfunction.sum(3,4)

print myfunction.sum(‘3’,‘4’)

print myfunction.sum(30,40)

print myfunction.sum(‘a’,‘b’)

Command Function

import myfunction

print myfunction.sum(3,4)

print myfunction.sum(30,40)

print myfunction.sum(‘a’,‘b’)

Table 4.7

 Command Function

def sum(a,b): The command to
formulate a function
called ‘sum’ for two
variables

c=a+b For adding the val-
ues assigned to two
variables and for
storing it as a third
variable ‘c’

return c

For returning the sum
of the values assigned
to the variables to the
program that used
this function

Table 4.6
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recognise that what was given as input
data were not numbers. In Python, the
symbol ‘+’ is used not only for adding
two numbers but for joining two strings
as well.

Activity: String Pyramid

Programme 5 provides the steps to
form a string pyramid. Type it down
and run it.

The same programme prepared
using ‘while’ is given in Programme 6.
Run the programme and correct errors
if any.

Program  5
s=raw_input(“Enter Your Name:”)
n=len(s)
for i in range(n+1):
   print s[:i]

Python Modules

Remember we had included the command ‘from turtle import*’at the
beginning in graphic programmes. You might also have noticed that the
command ‘import time’ was given at the beginning of programmes that include
commands concerning time. These commands are used to include Python mod-
ules such as ‘time’ and ‘turtle’ in programmes. For instance, when ‘time’
module is included in a programme using the command ‘import time’, all the
functions related to  time included in this module will be available in the
programme. We can also use ‘import’ command to include programmes that
we have already made in another new programme.

When we install Python in our system, several modules that have already
been prepared will be available with it. Such modules can be easily ‘imported’
to any programme. However, we can import a Python file to another Python
file, both should be stored in the same folder.

The Algebra within Strings

Strings are stored in a particular way. Note the few string commands and their
functions are given below.

print a[0]

print a*3

print a[:2]

print a[2:]

print a[-1]

print a.upper()

print a.lower()
Table 4.8

Command Function
a=“Good” For storing string ‘Good’ in variable ‘a’

print a For printing the contents of ‘a’

For printing the first letter of the string stored in ‘a’
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Python Code Generator
Wxglade is a software that helps in

writing Python programmes in
WYSIWYG (What You See Is What You
Get) method. This software is included
in the Programme menu. When you
open the software, the Properties win-
dow (Picture 4.2) and wxglade:Tree
window (Picture 4.3) open along with
the main window with the tool box (Pic-
ture 4.1).

Python Programming Using
wxglade

Picture 4.4 shows the window that
appeared while running a Python
programme. This Python programme
was written with the help of wxglade
software.

For constructing a window as
shown in Picture 4.4, you need to un-
derstand frame construction using

Program  6
s=raw_input(“Enter Your Name:”)
n=len(s)
i=1
while(i<n):
  print s[:i]
  i=i+1

wxglade, including labels and buttons
etc. These are explained below.

Constructing Frames using wxglade

♦ Open wxglade software from Pro-
gramming menu. Three windows
open in a row. They are: Main win-

Pic. 4.2

Pic. 4.3

Pic. 4.1
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dow (Picture 4.1), Properties win-
dow (Picture 4.2), and wxglade:Tree
window (Picture 4.3).

♦ Click ‘Add a Frame’ button in the
main window (Picture 4.1)

♦ In the window that appears (Picture
4.5), select wxframe option and
press OK. The <design> frame win-
dow opens (Picture 4.6)

Visual Programmes

Programming becomes easy when we use visual programmes. Visual
programmes are WYSIWYG models for computer programming. In ordinary
programming languages for instance, we have to type in the commands for
drawing a square. However in visual programming, we can use drag and drop
options the way we use in software such as writer.

Most of the important programming languages have visual versions. Vi-
sual C++ is the visual form of the programming language C++. With wxglade
software given in the programming menu of Linux, programmes in program-
ming languages such as Python, C++, Perl, XRC, and Lisp in WYSIWYG model
can be prepared.

♦ Simultaneously observe the changes
in the wxglade:Tree window (Pic-
ture 4.3, Picture 4.7). Name of the
new frame and Sizer would have
appeared.

♦ Click on the Sizer in wxglade:Tree
window. Select the appropriate Sizer
from Properties window. Arrange
<desing>frame window as shown in
Picture 4.10.

Including Labels and Buttons
The way to include label and but-

ton in the frame is given below.

Pic. 4.4

Pic. 4.5

Pic. 4.6

Pic. 4.7
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as wxglade:Tree window. With the
help of Widget tablet in Properties
window, change Label 1 to Number
1. Similarly change the second label
also. (See Picture 4.11).

♦ Adding text box: Click ‘Add a text
ctrl’ button  in the main window.
Following the same steps as those
used for making labels, click at the
appropriate places to include text
boxes as seen in Picture 4.11.

♦ Adding buttons: Click ‘Add a but-
ton’ in the main window to include
buttons in the frame. Once you add
the first button, two changes are to
be made in Properties. The first

♦ Making label: Select ‘Add a static
text’  in the main window (Pic-
ture 4.1) and click in the first box in
the <design> window. The label ap-
pears in <design> window as well

Pic. 4.8 Pic. 4.9

Nn{Xw 4.10

Sizer for Arranging Frame

Sizer is used to arrange rows and columns in frame window. The method
of arranging rows and columns using Sizer is provided below.

♦ Click Sizer in wxglade:Tree window (Picture 4.7). You will see a
corresponding change in the Properties window (Picture 4.8). Click on
the button  against Class in the window. From the Select sizer type
window that opens (Picture 4.9), select the appropriate Sizer type. If
you are constructing a frame with rows and columns similar to the one
in Picture 4.4, it is wxFlexGridSizer that you have to select.

♦ Now you can add the required rows and columns by right-clicking on
the Sizer in the wxglade:Tree window.
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change to be made is to change
‘Label 1’ in the widget tab in
Properties window. Then, you have
to include the function to be ef-
fected while clicking on ‘Handler’
in the ‘Event’ tab (In the activity, it
was given as ‘sum’). You also have
to select the second button and
uncheck Label 2 in widget tab.

Making Python Code
Following are the steps to write

Python codes similar to the arrange-
ments in the <design> window in Pic-
ture 4.11.

♦ Click ‘Applications’ in
wxglade:Tree window.  Then click
on the button  against the ‘Out-
put path’ option (Picture 4.13) in the
‘Properties’ window to select the
required folder and assign a file
name. Do not forget the .py exten-
sion.

♦ In the same window, select the
option ‘Python’, and press the but-
ton ‘Generate Code’. Python code
would be already made in the
recommended folder. Run this

Pic. 4.11

Pic. 4.12 Pic.  4.13

Changing the Label and its Contents

While making labels using ‘Add a static Text’button, the labels that formed
are typically named ‘Label_1’, ‘Label_2’. You can change the labels through
the following method:

♦ Click on the label that you want to change in wxglade window. Correspond-
ing changes can be seen in Properties window.

♦ You can also change the label by clicking on the Common tablet in the Prop-
erties window. Option to change the content in available in widget tab.
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programme by opening ‘IDLE’ us-
ing ‘Terminal’.

Activating ‘Form’
It is possible to add numbers in

cells while running the programme that
we have made. But we will not get the
sum if we click on ‘Add’ button. A way
to address this issue is given below.

♦ Open the Python file that we have
created. At the place where the
code of sum function appears (Pic-
ture 4.14), make changes similar to
the changes in Picture 4.15.

♦ Run the programme. The ‘Add’
button gets activated and the result
appears on the second button.

Pic. 4.14

Pic. 4.15

Pic. 4.16
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The data input into a computer
through text boxes are not numeric
data. These data has to be converted
into numeric data before used
for algebraic operations. For this, the
function ‘int’ is used in Python.

In Python language, we can use objects such as labels, text boxes, but-
tons just as we use variables. See the way names of text boxes and functions
are included in ‘sum’ function in the programme in Picture 4.18. Object names
are included in the programme as they are in wxglade:Tree window.

Pic. 4.18

A GUI Software for Me Too
Imagine, if you can open Writer, Calc, GIMP etc., using the software that

you have prepared! The Python code required to open some of the programmes
that you require often is given below.

from Tkinter import *
import os
def callback():
    print “called the callback!”
    quit()
def callback1():
    os.system(‘oowriter’)
def callback2():
    os.system(‘oocalc’)
root = Tk()
menu = Menu(root)
root.config(menu=menu)
filemenu = Menu(menu)
menu.add_cascade(label=“File”, menu=filemenu)
filemenu.add_command(label=“New Writer file”, command=callback1)
filemenu.add_command(label=“New Calc file”, command=callback2)
filemenu.add_separator()
filemenu.add_command(label=“Exit”, command=callback)
mainloop()

Pic. 4.17
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Follow up Activities

♦ Find out the output of the
programmes given below
Program 1

a = “o”
for i in range (1, 11):

print i * a

Program 2

a = “o”
c = “  ”
for i in range (0, 11):

print (10-i) * c,(2*i+1)*a

♦ Make adequate changes in the above
programme to construct the follow-
ing patterns

****** +ooooo
***** ++oooo
**** +++ooo
*** ++++oo
** +++++o*

1
111

11111
1111111

111111111

♦ A programme to reverse the word
PIT into TIP is given below. Rewrite
this programme into input method
a = “TIP”
n = len (a)
s = “”
for i in range (n):
       s = s+a[n-i-1]
print s

(1) (2)

(3)

Now make the Python programme for opening all the software that you
use in Class X.
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This is the gist of what famous
scientist Gordon Moore said more than
forty five years back about the speed at
which Information Technology was
growing.

We are able to use
computer and its related
peripherals with ease.
For this reason, don’t you
think it will be fun to
collect information about
the changes happening in
the field of computer and
its accessories? Let us
form groups which will
be responsible to gather
information about the
changes happening in
this area. A few tips for
this information gather-
ing are given below.

Mouse

Given below is the picture of
mouse and various interfaces to connect
the mouse.

Pic. 5.1

The number of transistors in an IC chip will double every year; that too without sig-
nificant additional costs. And this trend will continue at least till 2015.

                             Shri. Gordon E Moore., Electronic Magazine, April 1965

5 The Machine Called Computer
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Now a days we do not use the serial
connector.PS/2 is also fast disappear-
ing. One can see USB mouse and wire-
less mouse commonly.

The technology used in Mouse has
also undergone changes. Look at the
bottom side of your mouse. Mechani-
cal mouse worked based on movement
of the sphere like attachment in the bot-
tom. This technology was replaced by
the new mouse which works based on
the reflection of the light emitted by it.
See the speed at which technology gets
outdated!

The way ships are brought to
shore!

We refer to the computer we use
as System? The reason for this is
because we use keyboard, mouse,
monitor, and the system unit in a
integrated manner. How do we connect
all this to the system unit?

Port is the place where ships physi-
cally ‘connect’ to the shore. Similarly,
we have ‘Ports’ in the system unit which
‘connect’ input and output devices (also
storage devices) to the system.

Keyboard

Keyboard is an input device. To connect a Keyboard, the following interfaces
are available-PS/2, USB, wireless mode. (What is the usual colour of PS/2
connectors used with keyboards?)

The order in which the different keys are arranged in a keyboard is referred to
as keyboard layout. Most of us are familiar with the QWERTY keyboard
layout used for English language. This was originally devised to be used in
Typewriters. The layout of the keys was done with the intention that typing
levers should not get entangled while pressing the keys which are adjacent.
To overcome this difficulty, the layout is done in a manner such that the
alphabets most frequently used in the English are not placed side by side.
We know that while using keys in a computer keyboard they do not get
entangled. New keyboard lay outs enabling one to type faster based on the
speciality of the human fingers have been manufactured. Dvorak, Colemak
are examples of such keyboards. Layout of Dvorak key board is as in picture
5.2 below.

C-DAC, a body under the Government of India has devised a keyboard
layout called Inscript using which it is possible to type 12 Indian languages.
Layout of this keyboard is based on the similarity of the alphabets of these
languages. Key positions of alphabets are the same for all these languages.

Pic. 5.2
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Which Tool?Hardware
Interface

P.S.2

Serial

Parellel

VGA

USB

RJ45

TRS Plug
(Tip, Ring,
Sleeve jack)

Serial Modem
(Not in Use)

Dotmatrix Printers

Printer

Audio Input, Output
Ports, Analog Signal

Line In

Pic. 5.3

Projector
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We need ports in the system unit
which match the interfaces. Picture 5.3
shows different types of interfaces and
various ports which are used to connect
them to system. Fill up the blanks in the
Picture.

In different types of computers
such as laptop, net book, system unit,
monitor and keyboard are integrated as
a single unit. But do the ports to
connect external devices differ? Where
are the provisions for these ports?
Inspect and find out.

What is inside the box?

System unit is a box (system
cabinet) containing many parts of the
system. What are the units inside the
system cabinet? Let us learn in detail
about the various parts.

Microprocessor

Microprocessor is regarded as the
brain of the computer. It is here that the
processing of data as per the commands
is carried out. This is referred to as cen-
tral processing unit (CPU). Picture 5.4
shows a microprocessor called Athlo64
which is manufactured by a company
called AMD (Advanced Micro devices).

It is not necessary to open the
system unit to know about the CPU. We
can use the programme Sysinfo

(Applications → System Tools →
Sysinfo) for this. Observe the details of
the Intel dual core microprocessor as
shown by the software.

Now examine your system and fill
in the details in the table below

When we open a system unit, we
will not be able to see the processor as
in the previously shown pictures. When

Pic. 5.4

Pic. 5.5

System shown
in the Picture

The system that
you use

Manufacturer of the
microprocessor
Name of the Model

Intel

Pentium Dual-Core
1200 MHz
1024 KB

Clock Rate
Cache Memory (L2)

Table 5.1
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computer operates the processor heats
up significantly; hence we have a sepa-
rate cooling system for them. Picture 5.6
shows the heat sink and fan used to cool
the microprocessors

Activity 1

Inspect the systems available in the
school and tabulate the manufacturer
and model of the microprocessor. How
many manufacturers are you able to
list?

Mother Board- Foster Mother
to all Units

We have learned that there are dif-
ferent components which are integrated
and called the system. But who inte-
grates all these components?

It is an integrated circuit board
called Motherboard which enables this.
All components of the system are
connected to this board. In the comput-
ers of earlier days, there used to be
separate Integrated Chips (IC) pro-
grammed to carry out different func-
tions. As time moved on complex chips
were manufactured and were called
VLSI Chips- Very Large Scale Integrated
Chips. Every motherboard has two
VLSI chips. One is called the Memory
Control Hub (North Bridge, Host
Bridge), and other is called the Input/
Output Hub (South Bridge) .The
motherboard is known by the manufac-
turer of this Chip. Refer to Picture 5.7.

Pic. 5.6

Clock Rate

Think about the extent of information
exchange happening between the
CPU and other units of the system in
a single second. If the information
flow is not structured and stream-
lined, data reception and retrieval
will all become chaotic.

How is the working of the system
organised?

It is the quartz clock inside the CPU
which coordinates the functions
related to information exchange. It is
according to the beat of this clock that
the different units function. The pulse
rate of this clock is called clock speed

(Frequency) of the CPU. The unit for
this frequency is Hertz, for example
Pentium IV 3.2GHz.

Cache of CPU

CPU of a computer works at a very
high speed and invariably other units
cannot match this speed. Hence there
is a delay in information access by the
CPU. How is this problem resolved?

This is resolved by using intermedi-
ary storage mechanisms within the
CPU. Then the most commonly used
data and commands for a given user
can be stored there. This mechanism
is called CPU Cache. The storage ca-
pacity of this is referred to as Cache
memory in the previous.
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Which chipset does the mother
board of your system belong to? Run
the Sysinfo programme and inspect the
Hardware details. See Picture 5.8. Now
fill up Table 5.2. The motherboard with
the chipset shown in the table is referred
to as Intel 82945 chip set board

Activity 2

Inspect different types of
motherboard and identify the Slots and
the 2 VLSI chips in Picture 5.7. Find out
the manufacturers of such type of VLSI
chips. Are the same manufacturers en-
gaged in the trading of Motherboard?

Hard Disk for Information
Storage

See picture 5.9, are you able to
recognise the device? Operating
system, application software, and the
files that we generate – Most of the
things in a computer are stored here.

One or more disks connected to a
spindle – that is the structure of a hard
disk. Disks are coated by a magnetic
material.  Information is stored in the
disk by activating the magnetic
property of this material.

Input Output Ports

Slots for Add On cards

Power Connector - 1

Processor Slot

I/O Hub
Memory Control Hub

(Including Cooling Fan)

Power Connector - 2

BIOS
Battery

BIOS

Slot for connecting RAM

Slots for connecting Hard Disk, CD Drive and Floppy Drive
Pic. 5.7
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There are Heads that enable read-
ing from the disk and writing on it. It is
through the motorised rotation of the

disk and heads that all areas of the disk
are accessed.

Partition and File Systems

We get and empty hard disk while
purchasing a new one. In that state we
cannot store files generated by differ-
ent software in it. The reason is that the
disk does not have any locations de-
fined for storing files. We have define
certain parameters to enable storage and
retrieval of files.

We need divide the disk into
blocks or segments to know where a file

System showed above Your System

Producer of Chip set

Memory Control Hub
(Host Bridge)

I/O Hub, PCI/USB
Bridges

Intel Corporation

82945 G/GZ/P/PL

N10/ICH7

Table 5.2

Pic. 5.8

Pic.  5.9
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we will have to divide the hard disk
into separate parts. Such parts created
are referred to as hard disk partitions.
Sometimes a single operating system
may need multiple partitions.  In a Gnu/
Linux operating system following
partitions are suitable. (In some cases
only root and swap will be present)

♦ Root (/) - To store files related to
the Operating System.

♦ Home (/home) - To store files cre-
ated by the user.

♦ Swap - A high speed file system to
store data temporarily.

Pen drives, Memory cards, CD/
DVD are all devices to store data. To
read and write data from a CD/ DVD
we use a CD/DVD drive.

Activity3

When we purchase a pen drive,
there exists a file system in that. In
order to install a different type of file
system we use the program ‘Disk
Utility’ (System → Administration →
Disk Utility). Do not forget to un-mount
the drive before formatting.

is stored. These blocks need to be given
specific addresses too. This entire pro-
cess is referred to as Formatting of the
Disk. Each operating system does the
formatting in ways that are suitable to
them.

File system refers to the way a disk
is formatted by a operating system to
suit its requirements.

A few operating systems and their
corresponding file systems are shown
in the table.

What is to be done if we have to
install more than one operating system
in the same hard disk? This will require
different types of file systems. For this

Pic.  5.10

Operating
System

File Systems used

GNU/Linux  Ext3, Ext4

Microsoft
Wndiws (c)  FAT 32, NTFS

Apple  HPFS, HPFS+
Macintosh (c)

Table 5.3
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We need to create two partitions
with two different file systems - NTFS,
Ext3 in a pen drive with 4 GB storage
capacity. See picture 5.10.

Random Access Memory

We have understood that micropro-
cessors handle data in computers. Mi-
croprocessors are high speed devices.
Therefore the data to be processed them
and the related commands should be
made available at high speed to them.
But where is the information that has to
be fed to the microprocessor? This may
be stored in the hard disk or CD drive;
it could also be information being fed
real time. For processor to handle infor-
mation another interfacing device is
needed. Such a device is called RAM or
Random Access Memory.

♦ The information needed for the
computer to work is first tempo-
rarily stored in RAM and then made
available to the microprocessor.
Even the operating system, which
is essential for operating the com-
puter, is first moved to the RAM.
This process is what we call boot-
ing.

♦ One can access information stored
in any part of the RAM directly at
random. (Suppose we want to hear
the fourth song recorded in an au-
dio cassette which has six songs in

all. We have to first three songs to
reach the fourth song. This type of
memory is called serial access
memory. But in the case of RAM,
we can reach the fourth song di-
rectly without having to go through
the sequence.

♦ Even though RAM is a high speed
electronic device, it functions only
when there is power. All the data
in RAM is lost when computer is
switched off.

When we do tasks like video edit-
ing which require the user to open large
multiple files at the same time, the stor-
age capacity of RAM may not be suffi-
cient. In order to overcome this limita-
tion the best way is to create a separate
file system in the hard disk itself. The
file system thus created in the hard disk
is called Swap

Use the program Sysinfo and fill up
the table 5.3. Note that storage capacity
of 938 MB shown is what is available to
the user after making provisions for
different requirements of operating
system.  ( The actual storage capacity
of RAM could be much more)

Add On Cards

Suppose we want to see TV
programmes in the computer.  It is not
possible with the available features of

Pic. 5.11

Pic. 5.12
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BIOS (Basic Input Output
System)

We now know that when the sys-
tem is not running, the programmes re-
lated to operating system and others are
stored in the hard disk. The process of
moving these to RAM is called booting.
How will the RAM get the command to
understand that these programmess are
already present in the hard disk and
these have to be moved to RAM?
Wherein is such a programme stored?

This is done by the BIOS
programme stored in an IC Chip in the
motherboard. What all does the BIOS
do?

♦ As soon as the system is switched
on, BIOS does a test (Power On Self
Test - POST) to ascertain whether
all the units are functioning prop-
erly. We can see the result of this
test. You might have seen the mes-
sage appearing on your monitor
screen similar to what is shown in
picture 5.15.

♦ If there is a loose connection in the
port where the RAM module is

a computer when we buy it. We have to
add mechanisms to convert the analog
signal (coming through the cable) to
digital signal in the motherboard. We
use devices similar to the one shown in
picture 5.13, which are easily available.
These are called Add on Cards. Some
types of Add on Cards are listed in
Table 5.4.

Type of Cards Purpose / Use of the Card

Accelerated Graphic Card

T.V. Tuner Card

Sound Card

USB Expansion Card

Internal Modem

Network Interface Card

When we need complex graphics
while  using certain video games.

Table  5.5

For the
system

shown above

For the
System

used by you

Available
storage
capacity

Used Capacity

Swap Capacity

Used

938 MB

225 MB

0

956 MB

Table 5.4

Pic. 5.13
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connected, or if there is a dust coat-
ing, BIOS detects those. Find out
what the response would be.

♦ BIOS arranges programmes re-
quired for running basic hardware
like mouse, keyboard.

♦  BIOS boots the system. The oper-
ating system for booting may be in
the hard disk, in a CD in the CD
drive, or in a pen drive. We can

give instruction as to wherein the
operating system required for
booting is stored.

♦ BIOS keeps the systems clock tick-
ing even when the computer is
switched off.

Activity 4

Though most of the programmes
stored in a BIOS chip are not change-
able, we can set up a small part. This is
called the CMOS set up. When com-
puter starts operating, we can enter the
BIOS setup window by using any of F1,
F2, or Del keys (see picture 5.16).

Pic. 5.15

Pic.  5.16

Pic. 5.14
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♦ Check the time shown in BIOS; if the
time is wrong set the same.

♦ Set CD drive as the first boot device.
If CD drive is given as the first boot
device, only after checking whether
the drive has CD with the OS that
other components including hard
disk will be checked.

Check if the time shown in the sys-
tem clock is the same as the time shown
in BIOS.

Path of Electricity

What is the power requirement of
an ordinary computer?

It is not easy to answer ths ques-
tion. See table below:

What are all clear from the table ?

♦ All the devices work on DC -
Direct Current.

But we supply 220V AC to the sys-
tem. This has to be converted into
DC. In addition, the fluctuations in
the line voltage have to be over-
come

♦ Every component within the
system and outside work at
voltage levels suitabl to them.

In addition, all the components do
not work always (for example CD
Drive). And when they work,
power consumption varies accord-
ing to the nature of the task.

SMPS - Switched Mode Power
Suppy

This is the power house of a com-
puter. Based on the discussion above
can you list the various functions of
SMPS?

Direct current of various voltages
emanating from the SMPS reaches the
motherboard through cables of differ-
ent colours. See picture 5.18. You can

Pic.  5.17

Pic.  5.18

Device Operating
Voltage

Motor to run the disk
in CD drive and hard
disk

Microprocessor

12V DC

5V DC

3.3V DC

Different types of
digital circuits

1.3 - 1.5V DC

Table 5.6
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see the cables from SMPS and the power
connector used to join these to the
motherboard.

Can you see such a SMPS in a
laptop? Will you find out the alterna-
tive mechanism used there?

Follow Up Activities

1. “How fast is the Hardware technol-
ogy getting outdated”!  Prepare a
note on the transformation that com-
puters have undergone over the
years (Early machines, super com-
puters, personal computers,
laptops, net books, palmtops and
tablets).

2. Suppose we have been instructed to
prepare a proposal for buying
computers for our school. We know
how to find out the specifications
of the existing systems in the school.
Collect data about different systems
and their specifications available
today. Of these, what combinations
will you recommend to the school?
Conduct a seminar on the various
suggestions in all divisions of
class X.

3. Think about conducting a quiz on
hardware in the class. Questions
should be introduced as detailed
presentations.

4. What is to be done to install Gnu/
Linux in your system? See notes be-
low.

♦ Put the CD/DVD containing
the Operating system in the cor-
responding drive.

♦ Make this drive as the first boot
device.

♦ System gets booted from the
CD. Format the hard disk, cre-
ate partitions and file systems
for the operating system.

♦ Set Keyboard layout, system,
time zone of the country, name
of the user and password.

♦ ......................................................

......................................................

♦ ......................................................

......................................................
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Depicted above is the excitement
that Vinod, a student from Kozhikkode
district felt on completing his first ani-
mation film. Do you remember you ani-
mating a car using GCromp while
studying the part ‘Secret of Animations’
in the Class IX textbook of ICT?

What all did you do to animate the
car? Play the same game on your com-
puter once again and fill up the follow-
ing list.

♦ Selected the picture and brought
it on to the canvas.

♦ Included the picture in all the
frames.

♦ ............................................................

♦ ............................................................

You are beginning to understand
the method of animating still pictures
using software; aren’t you?

What we animated now is a picture
stored in the computer. What if we can
animate pictures that we have ourselves
drawn? We can do this using animation
software. If we are able to reproduce a
world of our imaginations in a
computer, don’t you think we will
experience the same excitement as
Vinod? We can use TuPi software
available in our operating system for
this.

Let us draw Pictures

We know that for producing ani-
mation we require several pictures. We
can draw these pictures in the anima-
tion software itself. Draw a picture in
Tupi with the help of directions given
below.

♦ Open Tupi : 2D Magic in Graphics
menu.

♦  Move in the order File → New →

“The first picture I drew on a computer was that of a butterfly. When its wings started
fluttering a little, It did not occur to me that I have animated it...it looked as if I have given
life to it...”

6 Let’s Give Life to Sketches
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New Project, Open the canvas win-
dow, assign Project Name and FPS
and click OK.

♦ You can select pencil from the tool
box and draw on the canvas.

Pic. 6.1 - Tupi : Main Window

Amination

Animation is the process of creating the impression of a motion picture by
continuous and speedy exhibition of two or three dimensional pictures. Once
we finish watching a picture, its impression remains in our visual field for
one-sixteenth of a second. Animation technology is based on this phenom-
enon called Persistence of Vision. Because of this, when a sequence of pic-
tures showing continuous action appears in front of our eyes, we see them as
a motion picture. Thomas Alva Edison was the founder of this technology.
Walt Disney, William Hanna, and Joseph Barbara are people who made major
contributions to this field. Tupi, Ktoon, Synfigstudio, Pencil etc., are 2D ani-
mation software available in GNU/Linux. Blender is a very good open source
3D animation software. Bigbuck Bunny, Elephant’s Dream, Sintel etc., are im-
portant animation films made using Blender.

Let us give life to a Butterfly

Haven’t you completed drawing
the picture? In order to make the pic-
ture move, we need the picture in more
than one frame. Find out the frame in
which your picture is available from



Let’s give life to Sketches

63

Suppose we want to exhibit the
animation that we are making at the
speed of six FPS. At that speed, how
many frames will be needed for an ani-
mation film of three minutes duration?
Discuss with your friends and copy the
picture into as many frames as re-
quired.

Have you included pictures in all
the frames as needed? Now the picture
is at the same spot in all the frames. For
instance, the positions of the first and
eighteenth pictures are the same. There-
fore when they move, we will not feel
any movement. What did we do to move
the car in GCrompis? Based on the study
notes, prepare an animation film by
making adequate changes in the posi-
tions of pictures in different frames and
try running the animation film.

Did you play the animation that
you have made? Do you think you
should make any change in it? Discuss
based on the steps given below and re-
solve it. Then make appropriate
changes in the animation and again play
it. If needed, take your teacher’s help.

♦ Isn’t it necessary for moving pic-
tures to look natural?

Layer 1 in Tupi main window. How do
we copy the picture into other frames?
Do we have to draw the picture in all
the frames?

We know that we can create copies
of a picture drawn in a computer using
Copy and Paste technique. By copying
the frame in Tupi to other frames, we
can copy the picture the required num-
ber of times. Copy your picture into
other frames with the help of the follow-
ing steps.

♦ For copying frame - Click on the
frame from which picture is to be
copied, Right Click → Copy frame.

♦ For posting to new frame - Click
on the frame to which picture is to
be pasted, Right Click → Paste in
frame.

The number of frames exhibited in a
second in a motion picture FPS
(Frame Per Second). A motion picture
of normal speed forms up when 12 -
14 frames move per second. We can
arrange the speed of a motion pic-
ture by adjusting the number of
frames.

For Changing the Picture Position in Each Frame

Select the frame containing the picture from the Layer Box in the Exposure
Sheet in Tupi main window. The select Object SelectionTool from the Tool
Box and change the position of the picture on the canvas relative to the
position of the picture in the first frame. When you select the entire picture
using this tool, several selection nodes appear around the picture. This is
because teach line created using Pencil tool stay separately in the picture. You
can move the picture only of all these lines are moved together. We can use
Arrow key for this. On the other hand, if the picture stays as a single entity
with just four nodes, we can move it using mouse. While moving a picture
using mouse, Ctrl and Shift keys can be used to control the speed.
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♦ We have changed only the posi-
tion of the picture in all the frames?

♦ ............................................................

............................................................

Let us Familiarise Tools

Now that you have drawn a picture
and animated it, list out the tools that
you have used and complete the table.

Now select the next frame and move the picture a bit ahead compared to the
preceding frame. Thus arrange all the pictures one by one according to a path
of the object that we want it to take.

To play the Animation

Click the Player menu. Click on the Play button below.

Let us save the File.

Use File → Save Project for saving a Tupi project file.

Pic. 6.2
A Picture drawn using the Pencil Tool in Tupi

For drawing a picture in Tupi,
two types of canvases are avail-
able – Background mode and
Frames mode. Pictures to be
animated are to be drawn on
Frames mode. For a picture to be
included in the background,
draw it in background mode.
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Scene 1

Pic. 6.3

♦ For drawing the picture Pencil (P)

♦ For selecting the picture ...............................................................

♦ To draw a line ...............................................................

♦ For zooming in ...............................................................

♦ ................................................... ...............................................................

♦ ................................................... ...............................................................

♦ ................................................... ...............................................................

Activity 1: Let Us Find a Story and
Prepare Story Board

Systematic preparatory work is
necessary for making animation films.
Story board preparation is an important
component in that. We have to first
convert the story into a Screen Play and
then into a Story Board. Details of each
scene is to be worked out in the Story
Board. Context of the story, still images,
moving pictures, the length of each
scene, details of dialogues or
background sounds if any etc., are to
be included in separate boxes and the
sketches of each scene should be
prepared. Even though it is better to
include everything that constitutes a
scene in a single box, a single scene can
also be drawn as different shots if
needed. It is after preparing detailed
Story Board like this that you should
start the production of an animation
film.

Complete the Story Board in
Picture 6.3 to 6.4. We shall make an
animation film out of this. Scene 2
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We can import pictures drawn using Drawing/ Im-
age Editig software applications into Tupi. Image
files with extensions .png, .jpg, .gif, .xpm can be im-
ported using InsertBitmap menu. It is .svg file that
can be inserted using Insert SVG File menu into the
canvas. When we make drawings in other applica-

tions for inserting into Tupi, background images should be drawn at the size
of Tupi canvas (width=520, height =380) where as other pictures such as char-
acters should be drawn in relatively smaller sizes. When body parts are drawn
separately using GIMP, you should delete the background layer and save the
picture in .png format.

Scene  3

Scene 4
Pic.  6.4

Have you completed the Story
Board? Remember how our last anima-
tion film lost natural movements as we
moved the pictures together. In the cur-
rent story board if we have to move the
characters in each scene separately, we
have to prepare their body parts sepa-
rately. Should we draw these in Tupi
itself? What if we draw the pictures

using image editing and drawing soft-
ware applications that we have already
familiarised with and import the pic-
tures to Tupi? If we draw pictures in
advance that way, animation produc-
tion becomes easier.

Which are the pictures to be drawn
for preparing the first scene? Analyse
the given study note and complete
Table 6.1.

Draw the pictures needed for the
other scenes too. For this you may use
Inkscape, GIMP, Expaint, Tuxpaint etc.,
which you are already familiar with.

Insert the background image for
first scene into Background mode and
insert the other pictures into the first
frame of Frame mode. Join the pictures
as shown in Picture 6.5 and prepare the
picture to be moved in the first frame.

Now insert the above frame into
other required frames and make the
changes needed for animation in each
frame. Play the animation and see.

Now that you have played scene
1, do you think any change is needed
in the movement of the character? What
was FPS that you had given to this
scene? Keep playing again and again
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Pic.  6.5

♦ Backgroumd - Size 520x380

♦ ......................................... - .........................................

♦ ......................................... - .........................................

♦ ......................................... - .........................................

Table  6.1

by changing FPS each time. Find out the most appropriate FPS and save. Don’t
we have to take care of this aspect in each scene? Discuss with your friends and
prepare for the other scenes.

Scene 1 Scene 2    Scene 3      Scene 4

FPS                          6                        ..................          ......................      ....................

Scene duration     3 Seconds ..................          ......................      ....................

Number of        18  ..................          ......................      ....................
frames

Table  6.2
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File Export

In order to save a file from Tupi as video, we have to export the file. For
exporting,  click File → Export Project. In the windows that open, select the
video file format and the scene to be exported and click ‘Next’. Then assign the
folder name and file name, specify FPS, and click ‘Save’.

Activity 2 : Exporting the File

You have now completed the first
scene. Now we are able to play anima-
tion only in Tupi software. Can we run
this file in other applications? Remem-
ber we had studied in previous classes
that it is necessary to export these files
into appropriate formats for playing

Pic.  6.6

We can enlarge Images

While making animation, in order to
achieve natural movement of
characters, we have to move the
picture into different places in a frame.
For this, select the inserted picture
using Object Selection tool. Then if you
click on the white mark in the middle,
you will be able to move the picture
around. You can also rotate the picture
by moving the selection node that
appears when you double-click on the
same mark. You can change the picture
size by dragging the selection nodes
on the sides.

them on Media Players. Export the file
into .avi format using the steps in the
given note. You may play the exported
file in an appropriate Media Player.

Once you are through with the first
scene, open new project file, prepare
other scenes also, export into .avi
format and save in a folder.

Pic.  6.7



Let’s give life to Sketches

69

♦ Join the scenes Openshot Video Editor

♦ Voice recording ...............................................................

♦ ..................................................... ...............................................................

♦ .................................................... ...............................................................

Onion Skinning

It is a technique used in animation films. It
is a method of showing multiple frames of the
same picture on the canvas. Seeing the
preceding and succeeding frames on the same
canvas gives us idea on the changes that are
required in each frame. We can arrange the
display of preceding and succeeding frames by
changing numbers in the Onion Skin box in the
Tupi Main Window.

Pic.  6.8

Activity 3: Joining the Scenes

Scenes are now ready; aren’t they?
You know that there are more steps
involved in completing the film as per
the Story Board. Which are the software
applications that we can use for these

steps that you have familiarised in
Class IX?

With the help of chapters 7 and 9
of the ICT Textbook of Class IX, join
all these scenes into a single video file
and export (Picture 6.9).

Pic.  6.9
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Even though Tupi allows preparation of more than one scene using Scene
Manager, the current version (Version 1.0) does not have to functions to add
animation sound and titles of our choice. For stages since joining of scenes,
you may use either Openshot video editor that you familiarised in Class IX or
other video editing applications available in GNU/Linux.

Follow Up Activities

♦ Remember the dialogue between
Damayanti and the Swan (Hamsam)
depicted in Nalacharitam

Pic.  6.10 - Zoom Out (50%) View

Another Way of Creating Motion

We moved pictures by chang-
ing their position in each frame. You
can also create the feel of moving
pictures by moving the background
in each frame while keeping the
character/object stationary. Objects
with stable trajectories such as
aeroplanes can be expressed in this
method. For this, we have to either
prepare the background in double
the width of the canvas or enhance
the width by dragging. Insert a
background picture thus prepared
into Frame mode and keep it in one
side of the canvas.

Or, in other words, move the
background in the same direction in
which the character has to move.
Remember, when you move the
background this way, it should fill
the canvas. Then insert the
aeroplane to be moved into the first
frame. Pic.  6.11

Now prepare the required number of frames by copying the first frame into
all other frames. Once all the frames are ready, select the background image alone
in each frame and move it in the opposite direction of the expected trajectory of
the aeroplane at exact distances. It is better to use Arrow key for moving the
background image.

Now play the animation using Player menu...

Attakkatha in Malayalam textbook.
Use Tupi to prepare an animation
of the swan flying down.
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♦ In the chapter ‘Protection and health
care’ in Biology textbook, the
process of Phagocytosis is
explained. Observe it and prepare
an animation film on the process.
Display it in your class.

♦ Analyse the chapter on Light
Phenomena in Physics textbook and

visualise dispersion of light using
Tupi software.

♦ Prepare a simple animation film for
awareness building on a
programme being organised in
school as part of anti-intoxicants
day.
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You had understood some basic
concepts of computer networks in the
chapter titled ‘Knowledge on your fin-
gertips’ in Class VIII.

You have been able to open pic-
tures prepared on a computer in an-
other one and make changes in the pic-
tures. This is possible because comput-
ers can be connected together through
networks. This chapter discusses how
these networks can be made use of in
computers that work on our operating
system.

Remember what you have learned
in previous classes. What are the advan-
tages of linking the computers in your
school lab through a Local Area Net-
work (LAN)?

♦ Computers connected through the
network can exchange information.

♦ Equipment such as printer con-
nected to a computer can be used
by other computers in the network.

♦ ............................................................

............................................................

♦ ............................................................

............................................................

In order to exchange information
between them, computers have to
recognise one another. How is this pos-
sible? Let us examine.

Pic. 7.1

7 Let us share Information
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Address of a Computer

Every system in a network is given
an address so as to recognise one an-
other. This address is called IP Address.
Do you know the importance and pe-
culiarities of IP address? Find explana-
tion to this question from the subse-
quent sections.

Let us now see how to figure out
the IP address of the computers in the
school lab.

Finding the IP Address of
Computers

Activity 1

Switch on the computers in the lab.
Also switch on network equipment
such as hub and modem.

Right-click on the icon of the net-
work monitor applet (NM-Applet) in
the panel and click on Connection In-
formation. (Picture 7.2).

See the window that opens. You
can see the IP address of the system
(Picture 7.3).

Pic. 7.2

Pic. 7.3

TCP/IP

All the systems that exchange
information over a network need not
be of the same type. They may be
different in hardware configuration
and operating systems. Therefore
there are some common laws that
control information exchange
between systems. These are called
network protocols. TCP/IP (Transfer
Control Protocol/Internet Protocol)
is a protocol for exchanging informa-
tion over networks. In this system,
every system needs to have a unique
IP address. There are two methods
used in assigning IP address – IP
Version 4 (IPv4) and IP Version 6
(IPv6). The most commonly used
protocol over Internet is still the first
version – IPv4.

Using the above method, find out
the IP addresses of all the systems in
the lab and fill up the second column
in Table 7.1. Now shut down all the sys-
tems. Now switch them on in a differ-
ent order, repeat the earlier exercise and
fill up the third column with the results.
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Structure of IP Address

IP Address is give in a format
with four numbers separated by dots
such as192.168.1.12. All these num-
bers should be lesser than 256 in
value. In our small networks, the first
two numbers would be 192.168. The
third number specifies the network (A
number for every network) and the
fourth number denoted the system (a
number for every system). IP address
is relevant only in a working network.
When a system joins a network, Au-
tomatic IP address is allotted tempo-
rarily using the technique DHCP (Dy-
namic Host Control Protocol).

Compare the IP addresses of
different systems. What are your
findings?

♦ These are addresses temporarily
assigned to systems when they
connect to a network.

♦ IP addresses are dynamic;  they

Computer
Number

IP address when the
system was switched on

the first time

IP address when the
system was switched
on the second time

1. 192.168.1.21

2. 192.168.1.___

3. 192.168.1.___

4. 192.168.1.___

5. 192.168.1.___

Table 7.1

changes every time a system con-
nects to a network.

♦ ............................................................

............................................................

♦ ............................................................

............................................................

The dynamic nature of IP address
becomes inconvenient for systems that
are permanently in a network. Every
time you switch on the system, you have
to check the new IP address.  How can
we resolve this problem? Naturally, the
easiest way is to set permanent IP ad-
dresses for such systems. Let us see
how this can be done.

Setting Permanent IP Address

Activity 2

Similar to what we did in Activity
1, right-click on the icon of the network
monitor applet in the panel given at the
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Pic.  7.4

top and click ‘Edit Connections’. In the
window that opens, select ‘Connections’
in the ‘Wired’ tab and click on the ‘Edit’
button (Picture 7.4).

A window appears. Select ‘Manual’
against ‘Method’ in the ‘IPv4 Settings’
tab, and click ‘Add’ button (Picture 7.5).

Address: 192.168.1.— (You may
use any number from 0 to 255 here. Two
systems in the same LAN should never
have the same number).

Under ‘Netmask’ type

Pic. 7.5

Pic.  7.6

255.255.255.0. Provide the combination
192.168.1.1 under gateway and for DNS
Server, and Apply (Save) (Picture 7.6).

When the window seeking pass-
word appears, provide the administra-
tion password.

You may assign a permanent IP to
each of the systems in the computer
network in your school’s lab. Once you
restart the systems, the new IP
addresses would take effect. Examine
and see. In short, the IP address of a
system is either assigned by the
network or by us according to our
convenience.

What we have discussed so far has
been about the software settings for
networking. Now let us examine the
hardware components needed for
networking.

Hardware Requirements

What are the hardware compo-
nents used in networking the comput-
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Pic.  7.7

Pic. 7.8

ers in our lab? Find out and complete
the list below.

♦ Cables

♦ Adapter

♦ ..........................................................

♦ ..........................................................

Prepare detailed notes of each
component? Some supporting informa-
tion is provided below :

Cables (UTP Cables –
Unshielded Twisted Paired
Cables)

Take out and examine a cable with
the help of your teacher (Picture 7.7).
Remove its outer layer and see.

♦ How many wires are there inside
the cable?

♦ Can you make these wires into
pairs of the same colour?

♦ How many such pairs are there?

Adapter Jacks

♦ Did you notice the way UTP cables
are plugged into the system?

♦ Did you notice the peculiar type

of adapters used ?

♦ These are RJ45 adapter jacks (Pic-
ture 7.8)

♦ How many pins (PIN) are there in
RJ45 adapter jacks?

Ethernet Card (Network
Interface Card)

Did you notice the component that
links the network cable to the
computer’s mother board? It is called
Ethernet card or Network Interface Card
(NIC) (Picture 7.9). This can be used as
an add- on card to the mother board.
The motherboards that are available
today have network interfacing cards
integrated with them. Therefore, we do
not have to add the card separately.

Hub/Switch

You know we can connect two com-
puters using a cable. What if there are
three or more computers? In that case it
is not possible to connect the cables
from different systems together. There-
fore the cables are connected to a com-

Pic.  7.9
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Pic.  7.12

Pic.  7.13

ponent which is capable of controlling
the data flow between computers. This
component is known as Hub/ Switch
(Picture 7.12).

Wireless Networks

You must have seen some lap top
computers accessing Internet without
any cable. What is the technology be-
hind this? Have you thought about it?
It is a technology called wireless net-
work. Instead of cables, what are the
data carriers used here? Are all the fa-
cilities of a normal network available in
a wireless network too? Try to find out.

What are usually the systems in
which wireless network is available?

Crimping

Crimping is the process of connecting connector jacks on both the ends of
UTP cables. The tool used for this is called Crimping Tool (Picture 7.10). There
is a specific order in which wires in a UTP cable are inserted into a RJ45 jack.
RJ45 is held as shown in Picture 7.11 and wires are inserted in the order given
below.

Pin 1 - Orange White Pin 5 - Blue White
Pin 2 - Orange Pin 6 - Green
Pin 3 - Green White Pin 7 - Brown White
Pin 4 - Blue Pin 8 - Brown

Crimping Tool (Pic. 7.10) RJ45 Pins  (Pic.  7.11)

♦ Some lap top computers

♦ ..........................................................

♦ ..........................................................

Is it possible to access wireless net-
works using desktop computers? What
are the components needed for this?
Find out.

Wireless Network –
Components

Try finding out the components
given in the pictures.
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Pic.  7.14

Pic.  7.16 Pic.  7.17

Pic.  7.15

♦  Wireless Modem ♦  Wireless Network Interface Card

♦  Wireless Router ♦  Wireless Network Adapter

Activity 4

Is it required to permanently set IP
addresses in wireless networks? What
are the disadvantages of setting IP ad-
dresses this way?

Activity 5

What are the usual problems that
the computer network in your school lab
encounters? List them down.

♦ Some of the systems in the lab can-
not be shared over the network.

♦ In some of the systems, while net-
work is available, Internet is not
available

♦ .............................................................

♦ .............................................................

How can we solve these issues?
Prepare detailed notes.

Activity 6

In the server in your computer lab,
a cartoon film has been saved on the
desktop with the file name foolfox.mpg.
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Pic.  7.18

Pic.  7.19

How can you display this on the desk-
top of your computer? Proceed accord-
ing to the steps given below.

♦ Open the Remote Desktop through
System – Preferences. Tick
‘Allow Other Users to View Your
Desktop’ and close the window
(Picture 7.18).

♦ Repeat the same step on all the
computers.

♦ Open the Remote Desktop Viewer
in the Internet menu of your
computer and click Connect

♦ In the window that opens, select
protocol VNC and type in the
server’s IP address at against Host.

♦ What does the window that
appeared on the server system
indicate?

♦ Aren’t you able to view the serve’s
desktop on tour screen?

Try copying this file to your
system. Does it allow copying? What is
the solution for this?

Sharing Files

Activity 7

Let us see what are the changes
required in system for sharing files. In
your system click in the order Places –
Connect to Server. Connect to Server
window appears. Provide settings in
the window as shown in Picture 7.19.

Select SSH as Server Type. Type the
IP address of the system that we intend
to connect against ‘Server’.  Provide the
Path of the folder to be connected
against the tab ‘Folder’ (For example,
in order to connect the desk top of user
‘its’, you should type /home/its/desk-
top).

Now you can connect by provid-
ing the user name of the system that we
intend to connect in the space provided
for that.

You can select options according
to the commands in the window that
appears. In the slot for password in the
next window, provide the password of
the system that we intend to connect.
Now you can connect the system.
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Pic.  7.20

Are you able to copy the cartoon
film from the server to your computer?
What are the advantages of transferring
files through network over using gad-
gets such as pen drive? Complete the
list below.

♦ You can copy to more than one
system simultaneously.

♦ ............................................................

♦ ............................................................

Now let us see how computers in
a network share a printer.

Sharing Printer

Suppose you have to prepare and
print a model of an application form for
registering students as members of the
IT Club. Printer is connected to the
server. You know that whichever com-
puter you use to prepare the model, you
will be able to print it from the server.
How is a printer shared for this pur-
pose? Do the activity described below
to understand this.

Activity 8

♦ Activate the network in the lab

♦ In order to share the printer in the
server, open the Printing window
in the server using the route Sys-
tem – Administration – Printing

♦ Click Server – Settings. Tick all the
check boxes in the window that
opens and click OK (Picture 7.20).

Do the same processes in the ma-
chine that you use, open the model ap-
plication form that has been prepared,
and print it. Did you succeed in print-
ing it?

The activities that you have com-
pleted just now have made you capable
of using the computer network in the
school lab effectively. There are lots
more to understand about computer
networks and the network of all net-
works – the Internet. We will do that
some other time.

Follow Up Activities

1. Prepare a directory of hardware
components used in networking
with their photographs and de-
scription.

2. List down the activities in the
school that can use computer net-
works. Examine how these activi-
ties are performed as of now.

3. A permanent IP address has been
set for a lap top computer using a
wireless network. What is the ma-
jor problem in doing so?

4. With help of Internet, analyse the
ways in which computer networks
are used in different sectors (Ex-
ample: Banks, Newspaper compa-
nies)

5. The network monitor applet in the
desktop of a computer used in
your lab has disappeared. Find out
how you can bring it back.
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You have seen School wiki,
Wikipedia, and the web site of the Gov-
ernment of Kerala and the Department
of Education. Which are the other
websites that you have visited? When
you open a web site in a computer in
the school lab, you are able to enjoy the
pictures, films, and songs from some
distant computer. Have you ever
thought as to how this is possible? In
order to understand the principles and
structure of websites, let us also build
a website. We will first make a website
which will be available only on the com-
puter in your school lab.

Every website is a combination of
web pages. You already know the
method of preparing web pages using
html tags. Tabulate the tags and their
uses that you are familiar with in
Table8.1.

Let Us Prepare

Let us build a website for present-
ing the various activities of our school

for the public to view. You should do
this in groups. Before preparing the
website, we should plan how our
schools’ website should be. For this,
some tips are given below.

♦ How many pages should the website
have in all?

♦ What should be the content in each
of the web pages?

♦ Which groups will be responsible
for preparing the different pages?

♦ ..............................................................

Use the model shown in Table 8.2
to make planning more effective.

 Tag Use
<html> for starting a Webpage
<h1> ...........................................
........... for make letters bold
<marquee> ...........................................
.................. ...........................................

Table 8.1

8 A Website for Us
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File Structure

While preparing a website, you
have to structure its contents systemati-
cally. We have to combine the web
pages prepared by different groups to
build the school’s website. Therefore it
is necessary that all the groups prepare
their contents in the same structure; be
it images, motion pictures, or sound.
Adopting a model shown in Picture 8.1
may be advisable for this.

Now that the planning process has
been completed, let us start making the
web pages.

Activity 1

Each group should prepare web

pages based on the topics assigned to
them and save them in a folder titled
MyWebsite. Include all the pictures in
the folder titled Images. In order to in-
clude these picture in the web page, use
the tag <img src=”imges/
Imagename.extension”>. It is better to
specify the location of the picture in
terms of relative path.

Relative and Absolute Path

There are two ways of inserting files
containing images, sound, video etc
into a website or while linking the
webpage to a file. The Absolute Path
of a file is the way of specifying the
Folder Name and File Name starting
from the file system. For example,
suppose you want to insert the pic-
ture sports.jpg in the images folder in
MyWebsite folder into the web page.
<img src =”/home/its/Desktop/
MyWebsite/images/sports.jpg”> tag
provides Absolute Path. Its Relative
Path will be <img src=”images/
sports.jpg”>. If Relative Path is given
along with the tag, all links will work
even if the system or location changes.

Group Content to be
included

Name of the page
that the group will

prepare

Names of sub-
pages (if needed)

Group 1 School athletic
meet

* Events
* Participants
* Results

Group 2

Group 3 Science Club

Group 4

Table  8.2

Pic.  8.1
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Adding Film in a Web Page

Adding a film on the web page that
you have prepared will make it more
attractive; don’t you think so? How do
we include films in the web page? You
have learned how to do video editing
in previous classes. Shoot any activity
in the school in video. Edit it as per re-
quirement and save in a folder titled
‘videos’. For example, if the video you
have prepared is say, dance.flv, by
shooting the school youth festival, then
the tag to be used will be <embed
src=”videos/dance.flv”>. Embed tag
can be used to add sound files too. Do
try it out.

Kompo Zer for Building
Website

You have practised preparing web
pages using html tags. What were the
difficulties you faced in preparing web
pages that way? The tags needed for
preparing a web site with several pages
would be numerous. There are appli-
cations that help us build websites
without using html tags. Such applica-
tions are called HTML Editors.

KompoZer, Quanta plus etc., are
HTML Editors. Whatever we can do
using html tags can be easily handled
using these applications.

A Few Tips for Using KompoZer

For inserting pictures

Click on ‘Image’ tool in the tool bar and browse the image to be inserted.
Then provide its name in ‘Alternate Text’ and press OK button.

For enlarging pictures

Click on the image; image size can be adjusted by manipulating the small
squares that appear along the image boundaries.

For inserting titles

Type the text in and do the required formatting.

For hyperlinking icons/texts

Click on Link tool after selecting icons/texts. Then browse the file to be
inserted and press OK button.
Inserting tables

Click on the Table tool and specify the number of rows and columns re-
quired. In order to format the table, right-click on the table and make the
changes you want.

For arranging the page by typing in html tags

Click the ‘source’ tab below at the bottom of the window for preparing
web page in KompoZer and make adequate changes.
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Figure out the changes that you can
make in web pages using KompoZer
and tabulate.

♦ We can change font size and colour.

♦ We can give background colour.

♦ We can change the image size.

♦ ............................................................

♦ ............................................................

♦ ............................................................

We can Make Pages Attractive

Shall we now make our web pages
more attractive using KompoZer? Open
KompZer from Internet menu. Then
open the web page that you have
prepared by clicking in the order : File
→  Open (Picture 8.2).

Make the page look more attractive

through adequate changes in font and
image size, location, background etc.
Save the file and open in the web
browser. Isn’t it looking more attractive
now?

An Attractive Home Page for
Our Website

Now that all the groups have pre-
pared the web pages, let us assemble
them to make our school’s website. You
might have noticed the home pages of
the websites that you have seen. Picture
8.3 shows the home page of the Depart-
ment of Education’s website. We too
need a home page for our website. Let
all the groups observe a few web sites
each and find out the various types of
contents that they would like to include
in the home page.

So, you have decided on what all
need to be included in the home page?

Pic.  8.2
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Now let us construct the home page.
Table 8.3 shows a layout that we can use
for it. Include pictures and logos to
develop your school’s home page.
From the home pages that the groups
have prepared, select the most
attractive one as the home page for the
school. See the instructions given in
relation to this.

♦ Open a new page in KompoZer,
assign Index.html as file name and
save it in the folder MyWebsite.

♦ Click on Table icon and insert a
table with three rows and three col-
umns

♦ For merging cells, select the con-
cerned cells and click Table – Join
Selected Cells. For example, for dis-
playing the school’s name, we
need to merge the second and third
cells in the first row.

♦ In order to hide the table grid lines

from appearing on the home page,
select the table and take Table –
Table Properties. In the window
that opens set Border, Spacing, and
Padding as zero in the table tab
and press OK button.

♦ You can insert text and images by
clicking on the cell.

♦ Link the web pages prepared by
the groups to the home page.

Present the web sites prepared by
the groups in a meeting of all the groups
and select one from the best. Entrust this
with the SSITC for building the school
website.

To See the Website We Built

With the help of your teacher, post
the website that you have built into the
file system folder var/www. Then type
localhost/iindex.html in the address bar
of the web browser and press Enter key

Pic.  8.3
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to view the home page of the web site.
For this, there should be web server
software installed in the system.

So, you have made the website
work. Now discuss the arrangements to
be made for making the website avail-
able on other machines in the lab. If you
type the server’s IP address with /
index.html in the address bar of the web
browsers of other machines and press
Enter key, the home page of the website
will be available on those machines as
well. For example, if the IP address of
the server is 192.168.1.4, then in order
to see the website in other machines,
one has to type 192.168.1.4/indec.html
and press Enter.

Activity 2

Get the IP addresses of the server
systems in which groups have saved
their websites and observe them.
Discuss the positive and negative as-
pects of the different websites and

present a report.

Our Website on the Internet

We could display the website that
we prepared on other computers in the
school lab. Can we display it on Internet
so that anybody anywhere in the world
can view it? There are two ways of do-
ing this. One way is to make our com-

School
Logo School Name

A Photograph of
the School

Important
News

•
•
•
•
•(Link to web pages

prepared by groups)

• Youth Festival
• Science Fair
• Study Tour
• IT Club
•
•

Information of the School

Table 8.3

Server and Client

Servers are computers that allow
various programmes to be be ac-
cessed by different users simulta-
neously. These are powerful ma-
chines with multiple processors set
up for specific purposes. Here we
will consider the system in which
our website is saved as server and
the other machines connected to it
through the network as clients. Cli-
ents can also use the resources
available with the server.
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Pic. 8.4

puter (server) regularly available on
Internet so that anybody can watch it
any time. Another way is to post our
website in a web server set up to make
the content available on the Internet.
Once we do that, just as we could use
the IP address of the server to see the
website from other machines, others can
see our website using Internet IP ad-
dress or web address.

Before making it available on the
Internet, compare your website with a
few other web sites on the Internet.
Won’t you like to make it more attrac-
tive? There are several tasks that require
technical skills in building web sites
(Compiling of web pages, designing).
There are software applications that
help you in these as well. They are
called content management system
software.

Let Us Start Building Website

Let us improve the web site that we
have built to overcome its limitations
and make it available on the Internet for
everyone to see. In order to do this, we
have to first select a web content man-
agement system software. Drupal is a
free and open web content management
system software. This GNU GPL based

software is the one that drives numer-
ous websites in the world. All the fea-
tures of commonly available content
management system (CMS) software
are available in Drupal as well. There
is an option in Drupal Gardens which
allows us to build a website without a
web server and software installation.
Let us see how we can build our
website using this.

♦ Enter the website of Drupal content
management system by typing
www.drupalgardens.com in the
web browser.

♦ Click on ‘create a free site’ button. In
the window that opens (Picture 8.5),
provide the URL that you want your
website to have (web address),
username for entering the website,
password, and your current e-mail
address.

♦ In the window that opens when you
press ‘Continue’ (Picture 8.6), you
can select the features that you want
to include in your website.

♦ Features such as Comments, Mail-
ing list, webforms, rotating banner,
and Media gallery and templates
such as FAQ, Forums, Blog, and
Contact Us are available here.
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From among these, let us include
the features Media gallery, Blog, Con-
tact us, and About for now. You can do
this by clicking On/Off button. Once
you press ‘Create’, a website with the
selected features is ready.

In order to validate the e-mail ad-
dress given at the time of web registra-

tion, you have to complete the registra-
tion process by clicking on the link that
has been sent to the said e-mail address.

Activity 3

Prepare a website featuring this
year’s activities in your school in
Drupal gardens.

Pic.  8.5

Web Content Management System (WCMS)

Web Content Management Systems are software applications that help us in
building websites, sharing information, making observations, and effecting
controls in the web system. We can make attractive websites and manage the
content easily using these applications. Some of the important WCMSs are
Wordpress, Joomla, Drupal, LightCMS etc. The CMS software are installed in
our computers (servers). Therefore we get the freedom to build websites on
our own computers (server).

 Several website templates are available in a web server in which CMS is
installed. Select an appropriate template. Make changes in the log and colours
to make it more attractive. Select the features that you want in the website (blog,
user login, gallery, social network link etc.), insert information, pictures, and
other documents; and your website is ready. You can make changes in the
existing template whenever you want. The changes thus made will be reflected
in the existing content.

Some WCMSs allow us to build our websites on their servers.
www.drupalgardens.com, www.lightcms.com, www.wordpress.com, and
http://sites.google.com are examples. Anybody with a e-mail address can open
a website on any of these WCMSs.
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Making the Website Attractive

Now you have built a fairly attrac-
tive website with a reasonably good set
of features. Now we can make changes,
add new features, or make it more at-
tractive the way we want.

Appearance

Once we log in to the website, the
menu bar for making changes appears
at the top (Picture 8.7).  Select ‘Appear-
ance’ menu from the menu bar for mak-
ing the website more attractive. The
window that pops up (Picture 8.8) of-
fers tabs such as Themes, Layout, Brand,

and Styles which can be used to make
the website more beautiful.

If you think the default theme is not
suitable for your website, there are sev-
eral themes in different structures avail-
able here. Click on ‘Choose a new
theme’ link and select another theme.
You may save and keep the new theme
by clicking on the Choose button and
assigning a name.

Do you want to make any particu-
lar part of the website more attractive?
For example, if you want to change the
colour of the site header, click on the site
header. As seen in Picture 8.9, in addi-
tion to showing the border of the se-
lected block, ‘The site-name in the
header region’ will be indicated in the
in the tab titled ‘You are styling’.

The changes that you make now

Pic.  8.6

Pic.  8.7
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will be felt within the boundaries of the
selected block. You can select any block
and modify the same way.

Even though the changes made in
the web site get saved in a timely man-
ner, these changes will be visible to only
us till we press the Publish button.
Therefore click on the Publish button so
that others can also see the changes
made (Picture 8.10).  Once modifications
are over, close the ‘Appearance’ win-
dow by pressing Close button.

Activity 4

Insert the school logo that we had

Pic.  8.8

Pic.  8.9

Pic.  8.10
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prepared in Inkscape in the school web
site. Make adequate modifications to
make it attractive.

Enriching by Adding More
Information

Now we have a beautiful website.
In a website what matters more than
beauty is information content. It will
become a good website only through
timely display and renewal of informa-
tion. Let us also enrich our website
including information on the day to day
events in the school.

Activity 5

In the school’s website, include
information on the activities in the
school, visits, digital objects prepared
by students and teachers, information
on excellence and achievements etc.

Information to the Web Page

As we had planned at the initial

stage in the website building process,
we have included pages for Home,
About, Blog, Contact us, and Galleries.
Now we have to provide the informa-
tion needed in these pages.

What are the information available
now in About page, which is expected
to hold information on the objective of
the web site and those who promote it.
In order to make changes and to include
more information, click ‘Edit’ menu
below the About page title  and include
relevant information (Picture 8.11). (This
menu appears only while you are
logged in).

Pic. 8.11

Pic. 8.12

WYSIWYG Editor

The abbreviation WYSIWYG stands for what You See Is What You Get.
WYSIWYG Editor has a window and editing tools similar to that of a word
processor. As the information added to this window is displayed as such on
the web page, it is easier to work with WYSIWYG Editor for developing web
pages.

There are two editors available for
adding information – HTML Editor and
WYSIWYG Editor (Picture 8.12).
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Inserting an Image

Do you want to insert the pictures
of important events in the school? We
know that pictures make web pages
more attractive. You can insert pictures
by clicking ‘Add Media’ in the
WYSIWYG Editor’s menu bar.

Media Gallery

Galleries help us exhibit a set of
pictures thematically. Include the
pictures of an event in which you
participated (art festival, study tour etc.)
in the gallery.

We can go to the existing Gallery
page by clicking the Gallery tab in the
Navigation bar. Replace the sample
gallery and pictures with the pictures
you have with you. You can insert more
pictures by clicking on the Add Media
button.

Create a new gallery and insert the
pictures that you have made in
Inkscape and GIMP. For adding more
pictures into this gallery, use Add
Media button

A New Page

You may need a new page to in-
clude descriptions of your participation
in school events, study tour report etc.
You can prepare new pages for each
theme by using ‘Content → Add Con-
tent → Basic Page’ in the menu bar.

Making Changes

You can modify or remove any of
the contents (page, article, post) in the
web site.

Changing Layout

There are several components in a
web page including header, links to
other pages, side bar, contents etc. Con-
tent management system prepares the
appropriate layout for different types
of contents. Typical page layout in-
cludes Pre header, Navigation, Banner,
Pre-content, page content, Side bar, Pre
footer, Copyright etc. However, we can
modify the relative positions of any of
the content blocks and change the lay-
out.

Follow Up Acitivities

♦ Design the web page for display-
ing the activities of your school’s
animation film production unit
using html tags. Colour the letters
and pictures to make it more at-
tractive. Collect pictures, anima-
tion films etc and include them in
the web page.

♦ Collect the web pages developed
by students in different divisions
and assemble them into a website.
Make the website beautiful by cre-
ating an impressive home page.

Content Blocks

Different types of content included in a website are classified into blocks. Main
menu, site logo, site name, Main banner, Main page content, and search form
are all different blocks. We can also construct new blocks. We can fix the
position of a block anywhere in the page layout. Navigation block (the link to
all pages) can be positioned on the side bar or pre header.
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Keep the website in a server so that
all the machines can access it.

♦ Include information on school

events and fairs in the website that
you have prepared using Drupal
Gardens.
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